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RESUMEN

Pier Luigi Nervi alcanzd reconocimiento mundial en la década de 1960 gracias a
su compromiso con el proceso constructivo. Con el hormigon armado, el ferrocemento y
la prefabricacidn consigue que sus obras sigan el criterio de la economia, fundamentos de
su ‘‘Sistema Nervi’’ que culmina en el Palazzetto dello Sport en Roma. El analisis
estructural de esta obra es el objeto del presente Trabajo Final de Grado. Para ello, en
primer lugar, se ha llevado a cabo un proceso de recopilacion de datos sobre el edificio y
su estructura para realizar en Autocad un modelo idealizado que posteriormente se ha
importado a SAP2000. Con esta Gltima herramienta se han definido los materiales, las
secciones de los elementos estructurales y las acciones a las que estan sometidos con el
fin de extraer resultados relativos a su respuesta frente a los Estados Limite de Servicio
(ELS) vy los Estados Limite Ultimos (ELU) segun la normativa vigente en la actualidad
(CTE). El comportamiento de la estructura del Palazzetto dello Sport es una muestra de
la gran sensibilidad estatica de Nervi, en él se refleja la union de la ingenieria y la

arquitectura en la expresion de lo resistente.

Palabras clave: Pier Luigi Nervi, Palazzetto dello Sport, Palacete del deporte, SAP2000,
sensibilidad estatica, ferrocemento, Sistema Nervi, estructura de hormigén armado.



RESUM

Pier Luigi Nervi va assolir reconeixement mundial en la decada de 1960 gracies
al seu compromis amb el procés constructiu. Mitjancant el formigd armat, el ferrociment
i la prefabricacié aconsegueix que les seues obres seguisquen el criteri de 1’economia,
fonaments del seu ‘‘Sistema Nervi’’ que culmina en el Palazzetto dello Sport a Roma.
L’analisi estructural d’aquesta obra és 1’objecte del present Treball Final de Grau. Amb
tal proposit, en primer lloc, s’ha dut a terme un proces de recopilacié de dades sobre
I’edifici 1 la seua estructura per a realitzar en Autocad un model idealitzat que
posteriorment s’ha importat a SAP2000. Amb aquesta Ultima ferramenta s’han defint els
materials, les seccions dels elements estructurals i les accions a les quals estan sotmesos
amb 1’objecte d’extraure resultats relatius a la seua resposta davant als Estats Limit de
Servei (ELS) i els Estats Limit Ultims (ELU) segons la normativa vigent en I’actualitat
(CTE). EI comportament de I’estructura del Palazzetto dello Sport és una mostra de la
gran sensibilitat estatica de Nervi, en ell es reflexa la unié de I’enginyeria i I’arquitectura

en I’expressio del que és resistent.

Paraules clau: Pier Luigi Nervi, Palazzetto dello Sport, Palauet de | ’esport, SAP2000,
sensibilitat estatica, ferrociment, Sistema Nervi, estructura de formigé armat.



ABSTRACT

Pier Luigi Nervi achieved worldwide recognition in the 1960s thanks to his
commitment to the construction process. With reinforced concrete, ferro-cement and
prefabrication, his works fulfil the economic criterion, based on his ‘‘Nervi System’’
which culminated in the Palazzetto dello Sport in Rome. The structural analysis of this
building is the main objective of this Final Degree Project (TFG). For this purpose, data
of the building and its structure have been compiled to draw on Autocad an idealized
model which has been imported in SAP2000. With this software, materials, sections of
structural elements, and the actions to which they are subjected, have been defined in
order to extract results regarding its response to the Serviceability Limit States (SLS) and
the Ultimate Limit States (ULS) according to codes enforced currently (CTE).
The structural performance of the Palazzetto dello Sport is a great example of Nervis’s
wide static sensitivity, where the bond between engineering and architecture shows the

expression of resistance.

Key words: Pier Luigi Nervi, Palazzetto dello Sport, Small Sport Palace, SAP2000,
static sensitivity, ferro-cement, Nervi System, reinforced concret structure.
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Figura 1: Palazzetto dello Sport, montaje de la cupula. Fuente: lori, 2009.

Figura 2: Palazzetto dello Sport, vista nocturna. Recuperado de: https://n9.cl/jwpa
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BLOQUE 1: INTRODUCCION

1. APROXIMACION A LA FIGURA DE PIER LUIGI NERVI Y SU
OBRA “EL PALAZZETTO DELLO SPORT’’> EN ROMA

1.1.PIER LUIGI NERVI. PERSONALIDAD NERVIANA

Figura 3: Pier Luigi Nervi. Fuente: Olmo y Chiorino, 2010.

Pier Luigi Nervi era el mayor representante de los ingenieros y arquitectos
italianos que se dieron a conocer en la década de 1950 y uno de los ingenieros mas
famosos del mundo (lori, 2009). En 1929 gan6 el concurso para el Estadio Municipal de
Florencia, su primera obra significativa que le daria reconocimiento en las estructuras de
hormigon armado (Nardiz, 2017).

La actividad de Nervi refleja un pleno compromiso en el proceso que va desde la
idea de proyecto a la construccidn del edificio. <’Proyectar es el hecho fundamental de la
edificacion’’ a lo que sigue “’la obra arquitectonica no se puede considerar como tal, si
no se hace realidad viva, de materiales y organismo apto para satisfacer las finalidades
funcionales y economicas para los cuales ha sido construida’’ (Nervi, 1945, p.1). Por



tanto, Nervi proyecta mirando directamente a la construccion, cualidad que le permitira
desarrollar sus patentes de procesos constructivos (Huxtable, 1966).

Analizando su respuesta a la pregunta “Scienza o Arte del costruire?”, titulo del
libro que publico para celebrar el fin de la Segunda Guerra mundial (Nervi, 1945), Nervi
realza la importancia de la interaccion de dos términos: arte y ciencia. Por otro lado, hace
hincapié en la absoluta conviccion de la intuicion estatica, como una sensibilidad y un
modo de proyectar (lori, 2009).

Como Perret, Nervi pensaba que ’el arquitecto es el maestro constructor que debe
encontrar en el lenguaje de la construccion las palabras necesarias para la maxima
expresion del arte’” (Nervi, 1956, p.28). Su vocacion artistica le permitia dar solucion a
los problemas estructurales y estéticos como un todo (Néardiz, 2017). Es por esto por lo
que Marcel Breuer (1970) no dudaba en calificarlo de ’ingeniero-artista’’ y compara sus
obras con las mayores obras del Gaético.

Esta expresion del arte, Nervi la consigue de la mano del nuevo material que
considera el mas fecundo material del que dispone la humanidad, el hormigén armado,
que por sus caracteristicas monoliticas puede ofrecer soluciones estaticas brillantes,
diluyendo los empujes en un organismo resistente (Nervi, 1945). En este, los esfuerzos
internos se propagan y se diluyen de unos elementos a otros conformando la estabilidad
del todo. Esta distribucion, que en muchas de sus obras se traduce en nervios y pilares
con secciones variables, apoya su postura, numerosas veces expuesta durante sus clases,
de que los constructores goticos fueron los predecesores de las técnicas modernas creando
un sistema de equilibrio entre nervios y arbotantes reproduciendo el flujo de las tensiones.

Un proyecto de arquitectura que satisfaga dicha distribucién de tensiones, segln
Nervi, dependiendo de la inconsciente capacidad del arquitecto, es expresivamente bello
(Nervi, 1965). Pier Luigi Nervi, manifiesta su preocupacion por la estética, en su libro
’Aesthetics and Technology in Building”’, a través de una mirada al pasado, busca la
relacion entre la estética de la arquitectura y la tecnologia de su construccion. En su
conferencia para el 25 aniversario del Instituto Técnico de la Construccion y del Cemento,
invitado por Eduardo Torroja, expresa su preocupacion por la division existente entre
ingenieros y arquitectos, y expresa su admiracién por el instituto por considerarlo como
una “’sintesis verdaderamente notable de la ciencia y de la belleza’’. En su “’Historia
Universal de la Arquitectura’’, en la cual se analiza la forma en que la técnica constructiva

y los materiales condicionan la forma, introduce cada tomo de la siguiente manera: ’las
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obras generalmente aceptadas por la critica formal, [...], como ejemplos de pura belleza,

son también, [...], el fruto de técnicas constructivas correctisimas’” (Nervi, 1972, p.1).
Nervi, en sus obras consigue esta union de técnica y estética, armonizando las tres

grandes categorias que sefiala: estatica, funcionalidad y economia, que constituyen para

él las causas principales de la grandeza y dificultad de la Arquitectura (Nervi, 1945).

1.2. ANTECEDENTES DE NERVI Y LEGADO

Si bien para Nervi los constructores goéticos fueron los predecesores de las técnicas
modernas (Nervi, 1959), el siglo XVIII puso los cimientos sobre los que se levantaria el
ingeniero profesional. En el afio 1776 Coulomb abordaba la investigacion matematica de
las estructuras estaticas, calculando la presion contra las paredes y el nimero y la
direccion de las fuerzas, asi como los puntos de fractura de ciertas bovedas. En el siglo
XI1X se refleja el progreso en la ciencia de las estructuras con la multiplicacion de escuelas
politécnicas en Francia, Alemania y Austria. La separacion en este tiempo entre
arquitectos e ingenieros era casi completa, reservandose la aplicacion de los nuevos
calculos estructurales a la construccion experimental de los ingenieros en sus puentes,
fabricas, estaciones de ferrocarril y palacios de exposiciones. (Huxtable, 1966).

Viollet-le-Duc (1854) consideraba que la arquitectura y la construccién debian ser
aprendidas o practicadas simultdneamente y que la construccion aportaba los medios y la
arquitectura era el resultado. Esta concepcion de la arquitectura era particular dentro de
una Era Victoriana, en la que contemporaneos como Ruskin definian la arquitectura como
la <’decoracion’’ de la fachada (Huxtable, 1966).

A mediados del siglo XIX, la arquitectura y la ingenieria se daban de la mano en
los grandes edificios para exposiciones. El Palacio de Cristal de William Paxton, en 1851,
disefiado y ejecutado por un ingeniero, ya presagiaba la prefabricacién y las estructuras
de armazones metalicos que pueden ser desmontadas, que, en el siglo XX, suponen una
auténtica revolucion de la arquitectura (Huxtable, 1966).

Pier Luigi Nervi nace en Sondrio, Italia, un afio antes de que Francgois
Hennebique, pionero en el hormigon armado, presentara su patente de 1892 en Francia e
Italia (lori, 2009). Pese a que anteriormente ya existian en los archivos de patentes
experimentos e inventos sobre este campo (patentes de Joseph Monier en 1867 y
Thaddeus Hyatt en 1878 como mas destacadas), Hennebique puede considerarse el padre

de la construccion moderna con hormigon armado, ya que su patente contemplaba la
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continuidad de la armadura de unas secciones a otras marcando el principio de la
construccion monolitica (Huxtable, 1966).

Nervi puede ser comparado en términos de posicion histdrica con el ingeniero
Robert Maillart, el cual Bruno Zevi describia como “’poeta’’ y “’escultor plastico’’ por la
ligereza y belleza de sus puentes y bodegas (Argan, 1993). La sensibilidad estética a las
nuevas formas que emergian de la ingenieria estructural quedan patentes en su Pabell6n
del cemento para la exposicion de Zurich de 1939 (Billington, 1979). En su estudio
monografico sobre Freyssinet, Fernandez Ordofiez (1978) sefiala que Maillart y Nervi
permanecen fieles al hormigon armado durante su carrera profesional mientras que
Freyssinet considera este material como un paso més dentro de una evolucion tecnoldgica.
A finales de la tercera década del siglo XX Freyssinet inventa el hormigén pretensado,
con el cual gana al propio Nervi en el concurso para el proyecto de la basilica enterrada
de Pio X en Lourdes. Segun Billington (1985), en la carrera de Freyssinet fueron los
medios de ejecucion y no la forma final, los que dominaron su imaginacion. Otros
representantes en distintos paises pusieron sus capacidades técnicas y estéticas en el
desarrollo de obras de arquitectura con hormigén armado. En Espafia, Gaudi (1852-1926),
Eduardo Torroja (1899-1961), Félix Candela (1910-1997) o en la escuela alemana, Franz
Dischinger (1887-1953) y Ulrich Finsterwalder (1897-1988). Billington distingue entre
la tradicion cientifica alemana, la constructiva artesanal en Espafia y la historica artistica
en ltalia, plasmada por la arquitectura nerviana (Néardiz, 2017).

Una nueva estética industrial estaba aflorando debido a las nuevas técnicas, hacia
1910 ya se habian patentado y utilizado numerosas unidades prefabricadas. Peter Behrens
en su fabrica de turbinas de 1909 o la fabrica Fagus de Walter Gropius en 1911,
constituyen una idea clara de la estética industrial. En 1907 con la disposicion del
“’Deutsche Werkbund’’ se marcaba el inicio de la colaboracion entre el arte y la industria,
precursor del movimiento Bauhaus de la primera postguerra y de la aceptacion de la
estética de la maquina y lo funcional. Todo ello llevé a la consideracion de las estructuras
ingenieriles como base de la nueva estética arquitectonica con una belleza radical
moderna. Nervi afirmaba que habia visto incrementarse el tamafio y grandiosidad de las
estructuras, hasta el punto de convertirse en tan aparentes que no podian ya quedar
perdidas bajo las decoraciones (Huxtable, 1966).

Es interesante comparar las distintas aproximaciones en el campo industrial a
partir de tres obras emblematicas de Freysssinet, Auguste Perret y Nervi: <’Les Ateliers

de confeccion Esders’” (Perret, 1919-20), <’Halle de Messagerie de la Gare d’Austerlich’’
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(Freyssinet, 1927-29) y la primera serie de hangares de Orvieto de Nervi (1935-38). La
confeccion Esders constituye el modelo ideal de la estructura porticada de Auguste Perret.
Con sus esbeltos arcos y plantas de poca altura consigue crear un espacio organico
construido a través de la economia del hormigon armado. Perret crea un esqueleto donde
estructura, espacio y luz se funden en el monolitismo del hormigén, dando la apariencia
casi de una “’maquina de luz’’ (Perret, 1935). Freyssinet, por su parte, reduce la cantidad
de material empleado en cualquier circunstancia. Compone tres bdvedas paralelas,
contrarrestadas por los pilares y porticos de las fachadas laterales, la estacion de
mensajeria de Asterlich, constituye una pieza maestra de la técnica constructiva, con unas
marquesinas laminares que se prolongan hacia el exterior, pionera de las laminas de
hormigdn armado, muy anterior a las de Torroja y Maillart. Mientras que la parte baja del
edificio es monolitica, la superior se divide en secciones con juntas de expansion; todo el
esfuerzo de proyectar se centra en el aligeramiento de la estructura, correspondiendo cada
seccion a su funcion en el sistema de cargas. August Perret definia la arquitectura como
el arte de organizar el espacio, Freyssinet la traduce como el arte de construir donde el
espacio se conforma por el peso de la materia resistente (Fernandez, 1978). Esta Gltima
definicion se aproxima mas a la de Nervi. Entre la arquitectura y la ingenieria que se
muestran en estas tres obras, Nervi se sitda del lado de la arquitectura. Para Nervi (1956),
el nombre méas adecuado para un hombre capaz de concebir y construir una estructura es
el de arquitecto. En los hangares de Orvieto, con sus nervios curvados en cuadricula y los
pilares inclinados, Nervi, segun Desideri, Nervi y Positano (1982), consigue una
abstraccion entre el espacio y la estructura. EI hormigén armado en la arquitectura de
Perret adoptaba las formas grandiosas pero clasicas de los encofrados de madera. Nervi

en sus obras pretende liberar el hormigén armado de las matrices lefiosas (Nervi, 1956).
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Figura 4: Les Ateliers de confeccion Esders. Figura 5: Halle de Messagerie de la Gare
Fuente: Olmo y Chiorino, 2010. d’Austerlich. Recuperado de: https://n9.cl/0Ogsy
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Figura 6: Privera serie de hangares en Orvieto. Fuente: Olmo y hiorino, 2010.

En los afios 30, el hormigon armado ya habia sido ampliamente utilizado,
acreditado arquitecténicamente en obras como la casa de pisos del 25 bis de la calle
Franklin en Paris, donde Auguste Perret marcd un hito del movimiento moderno con sus
voladizos y visible armazén de hormigon (Huxtable, 1966). Técnicamente, también
estaba ya consolidado el uso del hormigon armado en los hangares de Orly de Freyssinet
(1921-23), donde se rebajaron al minimo los costes de construccion gracias a la
colocacion por encima de las bdvedas los arcos formeros, no por debajo como era
habitual. De este modo, los nervios quedaban al exterior y el intradds quedaba liso, lo que
permitia cimbras deslizantes. Torroja, por su parte, también defendia las superficies lisas

en el interior para abaratar los costes (Nardiz, 2017).
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Figura 7: Hangares de Freyssineten Orly. Fuente: Nardiz, 2017.
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La aportacion de Nervi con sus primeras obras conocidas, desde el Estadio de
Florencia (1932) a la primera serie de hangares de Orvieto (1935), daria al hormigén
armado, ya madurado durante décadas, un nuevo avance tanto estético como técnico,
consiguiendo resultados que justifican su reconocimiento universal. <’El encofrado de
madera es un camino obligatorio hacia las formas tipicas de la madera, la cual restringe
la libertad de las estructuras de hormigédn. Esta limitacion estructural se une a la
econOmica, causada por el progresivo aumento del precio en relacion con la complicacion
de las superficies, o de su curvatura, asi como muchos elementos estructurales no
pertenecen a la banalidad de las formas prismaticas, o superficies planas’’ (Nervi, 1965,
p.41).

El problema para Nervi era encontrar el modo de construir estructuras curvadas o
nervadas respetando los principios de economia estructural y de costes de construccion.
La respuesta vino con el “’Sistema Nervi’’, proceso de construccion a través del cual las
estructuras mas complejas se convertian en simples y econdémicas. El éxito de su método
fue posible gracias al trabajo conjunto del prefabricado y del ferrocemento, ambos
conocidos con anterioridad pero nunca antes aplicados de manera conjunta. El
extraordinario potencial de la combinacion de estos dos precedentes permitio liberarse de
los encofrados de madera y conseguir resultados en términos de tiempos de ejecucion y

costes econdmicos excelentes (Poretti, 2010).

1.3.UN NUEVO MODO DE CONSTRUIR

Las caracteristicas del ferrocemento y los métodos de su implementacion
representan las ideas mas importantes en la vida profesional de Nervi. El entusiasmo con
el cual presenta su invencion en la ciencia y el arte de construir muestra cémo Nervi,
experimentado y consciente de los problemas de la construccion, se esta dando cuenta de
la arquitectura misma. ElI hormigon armado, inicialmente destinado a reemplazar
simplemente la piedra, la madera y el hierro, fue conquistando, en las primeras décadas
del siglo, la dignidad de aparecer desnudo como un nuevo termino de lenguaje. La
primera serie de hangares de Orvieto (1935-38) habian mostrado la dicotomia no resuelta
entre estructura y arquitectura con la carcasa de cubricion que ocultaba su fuerza
expresiva. Hacer coincidir estructura resistente y forma era un objetivo ambicioso que se
resolveria en futuras obras (Greco, 2008). Poco antes, en 1939, The Cement Pavilion en
la Exposicion de Zurich, de Robert Maillart, ya habia demostrado esta posibilidad
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(Giedion, 1941). Segun Filetti (1999), el desarrollo y la investigacion, ain hoy vigentes,
sobre cementos reforzados con fibras, muestran como Nervi estaba en el camino correcto
para un progreso decisivo en el uso del hormigdn armado.

El almacén experimental de la Magliana en Roma (1945) fue su primera
aplicacion de los nuevos experimentos sobre hormigon armado. Se trata de un pequefio
almaceén en el terreno de su empresa (21 x 12 m), totalmente construido con ferrocemento
de 3 cm de espesor. El progreso que experimentd durante el cese de su practica
profesional por la guerra le hizo aplicar su experimentacion a esta primera construccion.
Las losas de ferrocemento estan conformadas para adquirir, con la forma, las resistencias
necesarias para crear una envoltura estructural que realmente coincida con la forma del
edificio mismo, gracias a la libertad de poder prescindir de los encofrados. El pequefio
almacén se resuelve con un tnico modulo de perfil ondulado, que se repite alternado con
secciones rectas que permiten la insercion de ventanas y puertas. Este perfil es la sintesis
de la sensibilidad estética y la sensibilidad constructiva. Los mddulos de ferrocemento
consisten en una estructura ligera de soporte, formada por barras de 5 mm cada 20 cm
sobre la que descansa una malla metélica de 1 kg / m2, cubriéndose con un mortero de
aridos finos de buena calidad y cemento con bajo contenido de agua que, bajo la presion
de colocacion, llena los intersticios entre las capas de malla. Nervi es consciente de la
importancia de su experimentacion y define el pequefio almacén en numerosos detalles a
escala 1:1; utilizando el nuevo material (de 3 cm) no solo para las paredes de soporte,
sino también para todos los elementos de terminacion: alféizares, aleros y pilares huecos
reforzados (Greco, 1994).

i £ POOSETT) i 438

Figura 8: Almacén experimental de la Magliana. Fuente: Greco, 2008.

La posibilidad de combinar las ventajas de la prefabricacion, desarrollada en los
hangares de 1939, y el ferrocemento, que se esta perfeccionando en Magliana, encuentra
una oportunidad Unica para su experimentacion en su obra ‘’Cobertizo para maquinaria
agricola en Torre in Pietra, Roma’’ disefiado por la arquitecta Michele Busiri Vici. El

permiso de construccion esta fechado el 11 de enero de 1945 e incluye un complejo de
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edificios rurales con una instalacion agricola tradicional a gran escala para el
almacenamiento de vehiculos y material, donde Nervi decide aplicar sus innovaciones
constructivas. La gran sala de 18 x 36,60 m, aunque terminada con teja tradicional,
dispone de una estructura de delgada losa acanalada, retomando los conceptos estaticos y
formales ya aplicados en los hangares de 1936 y 1939. El techo se divide en rombos, pero
la verdadera novedad para el cobertizo agricola en Torre in Pietra es el proceso de
construccion. En las dos series anteriores de bovedas para los hangares, se avanza desde
un complejo cimbrado de madera a la subdivision en elementos prefabricados de los
nervios, ensamblados en los nudos. El siguiente paso, experimentado en Torre in Pietra,
era crear una estructura monolitica utilizando médulos prefabricados de ferrocemento que
realizan la doble funcion de encofrado perdido resistente que conforma al mismo tiempo
los nervios. La geometria mas compleja se construye en una porcion del almacén a la
misma escala en un area contigua, donde verificando su geometria con precision, se
ejecutan los médulos de ferrocemento a mano. Una vez endurecidos y debidamente
numerados, se ensamblan para reconstituir toda la superficie de cobertura. En este punto,
se refuerza los espacios entre los médulos y se vierte hormigon para formar un todo solido
y monolitico (Greco, 2008).

Para Nervi (1965) el hormigon armado es el material mas fecundo que la
humanidad haya inventado. El hecho de poder crear una piedra con cualquier forma lo
considera como magico y del monolitismo nace su brillante solucién estatica. Por otro
lado, prever el comportamiento de las estructuras de hormigon armado seria un obstaculo

superado mediante la experimentacion en modelos.

1.3.1. LA PREFABRICACION

La publicacion de los hangares en revistas de arquitectura renueva la fama y el
éxito de Nervi algunos afios después del estadio Berta. En la primera serie de hangares
en Orvieto (1935-38) los elementos estructurales se realizaron con un gran desperdicio
de material y tiempo. El deseo de poder disefiar nuevas arquitecturas de tal complejidad,
pero con una reduccion en los medios y dificultades, se convierte en el impulso para
mejorar aun mas su proceso de construccion. Por otro lado, este era también el imperativo
en la Italia de la autarquia (lori, 2009). Nervi intensifica sus experimentos y finalmente
alcanza otro objetivo: la prefabricacion (Greco, 2008).

La prefabricacion estructural de Nervi se ubica en la historia del hormigon armado

después de recordar, como primer ejemplo de aplicacién en lItalia, la construccion, en
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1908, del Ponte Risorgimento en Roma, por el ingeniero Porcheddu basado en la patente
de Hennebique. Sin embargo, su maestro Muggia, menos conocido, ya habia
experimentado esta técnica antes del 1908 en el laboratorio de estructuras de Bolonia
(Greco, 2008). Al final de los afios cuarenta Nervi tuvo que dar solucion a techos de
grandes luces con su técnica de ‘’prefabricacion estructural’” que consiste en
descomponer la estructura en partes individuales que no tienen en si mismas una funcién
estatica concreta (como seria el caso de vigas que fueron prefabricadas en sus longitudes
definitivas y refuerzo metalico) y que solo después de ensamblar todos los elementos
mediante la soldadura de todas las piezas prefabricadas se consigue una estructura
monolitica estable. La primera aplicacion para su método en su obra fueron la segunda
serie de hangares en Orvieto (1939) (lori, 2009; Poretti, 2010).

Pese a la originalidad que le concedia Nervi a este sistema, Henry Lossier en 1915,
Francia, ya habia aplicado este método conectando las piezas con cementos especiales,
aungue para estructuras de menor tamafio. Con este procedimiento se permitia solapar
fases de construccion y conseguir un ahorro de materiales, mano de obra y tiempo. Segun
Greco (2008), la invencién de Nervi, sin embargo, parece ser el fruto de una larga
elaboracion personal, sobre todo dirigida a la expresion de un lenguaje arquitectonico
especifico, a diferencia de los experimentos practicados por muchos otros ingenieros. La
calidad arquitectonica de sus estructuras es lo que le otorga primacia en el sistema de
prefabricacion.

En 1939 Nervi patenta una serie de vigas arqueadas prefabricadas que se conectan
entre si mediante soldadura en los nudos. En Magliana se ejecutan modelos a escala real
para llevar a cabo las pruebas de carga necesarias. La patente también incluia un sistema
reticular de vigas transversales en prevision para prefabricar la misma estructura que
tantos medios habia supuesto en la primera serie de hangares (Greco, 2008)

A finales de 1939, con motivo de un nuevo concurso de Aerondutica Militare,
Nervi gand la construccion de una nueva serie de hangares (en Orvieto, Orbetello y Torre
del Lago Puccini), disefiados de forma similar a los dos de 1936, pero esta vez
completamente prefabricados. Son importantes las innovaciones arquitectonicas del
sistema general en comparacién con la primera serie. La planta y el esquema estructural
son simétricos y, los soportes, pilares inclinados con una reduccion drastica de material
en toda la estructura. La boveda repite la disposicion con nervios cruzados de los
anteriores hangares, pero la simplificacion debido a la prefabricacion permitio el

aligeramiento de los nervios que se vacian del material innecesario, manteniéndose solo
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algunos macizos en el area central, donde se concentran los mayores esfuerzos. Las juntas
entre los prefabricados se realizaron soldando el acero y vertiendo hormigon de alta
resistencia. La eficiencia de su sistema de prefabricacion estructural para conseguir una
estructura monolitica acorde a la naturaleza del hormigdn armado se demuestra, de
manera tragica tras la destruccion por los alemanes con su retirada, viendo en las ruinas
que la mayoria de las juntas permanecian intactas. En estos hangares es donde consigue
Nervi, a través de su sistema constructivo y la experimentacion en modelos, el rigor
compositivo y economia que buscaba (Huxtable, 1966; Greco, 2008; lori, 2009; Poretti,
2010).
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Figura 9: Segunda serie de hangares. Fuente: Olmo y Chiorino, 2010.

1.3.2. EL FERROCEMENTO

La prefabricacion de ferrocemento permite a Nervi alcanzar nuevos horizontes de
disefio, que previendo su potencial traducird en patentes. El ensamblaje de piezas
prefabricadas de ferrocemento permitiria lograr una libertad creativa nueva respecto a la
construccion tradicional con encofrados de madera. El ferrocemento maduraria en las
construcciones navales, a las que Nervi se dedica en este primer periodo y gracias a las
cuales experimenta el material de forma adecuada para un progreso real en la
construccion. En 1904, Silvio Canevazzi, profesor de mecanica aplicada a la construccion
en la Real Escuela de Ingenieros de Bolonia, acufi¢ la palabra ferrocemento en italiano,
probablemente por primera vez, combinando las dos palabras de los componentes
principales del hormigén armado, aunque se referia al hormigon armado tradicional;

Nervi, afios despues, redescubre el nombre, asociandolo con un procedimiento
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constructivo que €l considera innovador pero que, de alguna manera, devuelve a los
origenes distantes de esta técnica. Ciertamente, el ferrocemento no era mas que la
traduccidn literal del término utilizado por Joseph - Louis Lambot, uno de los pioneros
de esta técnica constructiva, para indicar el material con el que llevo a cabo, mas de
cincuenta afos antes, su ‘’barco imputrescible’’ (Greco, 2008).

La patente de 1855 de Lambot describié una combinacién de hierro y cemento,
llamada ’fer ciment’’, que reemplazaba a la madera de encofrado. Indica el proceso, que
consistia en formar un refuerzo de metal dandole la forma mas adecuada para el objeto a
obtener para rematarlo con cemento hidraulico (fig. 2). Unos afios mas tarde, en 1867,
Joseph Monier también ilustré su patente para un sistema de maceteros de hierro y
cemento aplicados a la agricultura, hacia su forma en barras de hierro redondas o
cuadradas y alambre de hierro en forma de parrilla, cubierto con cemento de todo tipo
con un espesor de 1 a 4 cm (Monier, 1867). Las primeras aplicaciones significativas de
los dos materiales conjuntamente, generalmente reconocidos en el origen de la historia
del hormigon armado, fueron por lo tanto, segin Fougerolles (1949), solo
“’contenedores’” o “’encofrados’’. Hennebique, desde 1892 introdujo una concepcion
diferente, creando vigas y pilares con un conglomerado de grava y hormigon armado con
barras de hierro. Con las sucesivas patentes de Monier y de otros pioneros como
Cottancin, se desarrolld el uso del hormigon armado con poco espesor. En Roma, por
ejemplo, Carlo Gabellini, empresario de la construccion, entre 1896 y 1898, presentd una
serie de patentes que perfeccionaron precisamente esta forma de utilizacion usando
cemento reforzado para crear espesores muy bajos (Gabellini, 1896; Gabellini, 1898).

Las caracteristicas méas destacadas del ferrocemento fueron la ligereza, la facil
reparacion y la ejecucion con medios muy simples sin encofrado. A pesar de la rapida
fama también adquirida en el extranjero por la firma Gabellini, poco se habia investigado
el comportamiento y sus posibles aplicaciones. Cuando Nervi comenz6 su aprendizaje en
la construccidn junto a su maestro Muggia, pudo verificar directamente la versatilidad de
esta forma particular de concebir el hormigdn armado en la fabricacion de todo tipo de
objetos que Muggia producia (Greco, 2008).

En 1917, Nervi presenta su primera patente prematura, una mezcla de cemento
reforzada con virutas de hierro, y en la segunda mitad de los afios treinta, volveria a
estudiar esta combinacion mas a fondo con un nuevo objetivo: el ferrocemento. Entre
finales de la década de 1930 y principios de la década de 1940, Nervi comenzd a presentar

una serie de patentes para la armada italiana en las que utilizaba cada vez elementos méas
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delgados hechos de mortero de cemento y malla de alambre (patentes para la cobertura
de un torpedo subacuético y una boya de amarre), verificando su flexibilidad constructiva,
impermeabilidad, ligereza y ahorro de material; cualidades que pronto aplicaria en las
construcciones navales (Greco, 2008).

Desde las pequefias embarcaciones pioneras de Lambot el uso del ferrocemento
ha acompafiado a la historia de la construccion naval. En Italia esta practica ya estaba
muy extendida a principios de siglo por el maestro del propio Nervi, Muggia. A mediados
de los afios treinta la Marina solicita a Nervi el disefio de algunos barcos de guerra, para
los cuales reanudd el uso de esta técnica. En este punto, con el estallido de la guerra, las
actividades de construccion se pausan; Nervi se concentrara en sus estudios y har un

balance del curso de la investigacion de treinta afios (Greco, 2008).
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Las escaleras de Florencia y los hangares le habian revelado las limitaciones que
representa el encofrado para la gran plasticidad del cemento. En 1943 Nervi presenta su
patente, aumentando la difusion del hierro y su porcentaje, crea un material de mayor
resistencia y, sobre todo, de mayor elasticidad y alargamiento: el ferrocemento
(Abercrombie, 1977). Con espesores que varian de 1 a 6 cm, su material se crea reforzado
con multiples capas de malla superpuestas de peso variable (hasta 1.5 kg / m2) junto con
un conglomerante de mortero de cemento y arena fina. El verdadero avance es la
liberacion de las formas de los encofrados de madera, ya que la malla metalica es capaz
de retener el mortero aplicado presionando con una llana. Los resultados obtenidos fueron
respaldados por las primeras pruebas en laboratorio realizadas por Guido Oberti en el
Politécnico de Milan (Grandori y Oberti, 1948).

Nervi consigue asi crear membranas resistentes a la compresion y traccion,
onduladas o plegadas, donde la coincidencia entre forma y estructura es posible, con una

reduccién de material y con una libertad creativa nunca antes alcanzada. Sus primeros
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proyectos hipotéticos, no realizados, como un hangar circular o una ctpula de 300 metros
de luz que cubre la plaza de San Pedro en el Vaticano, pretenden mostrar los resultados
que se podian lograr con el ferrocemento, donde, segun Greco (2008), su forma simple y

sinuosa revela la sintesis de la construccion nerviana.

1.3.3. SENSIBILIDAD ESTATICA

La adaptabilidad del hormigdn a cualquier forma y la capacidad de resistir los
esfuerzos que Nervi consigue con la prefabricacion y el ferrocemento, le permite crear
estructuras que respondan al flujo de tensiones que se produce en su interior,
convirtiéndose en la materializacion exacta de los esfuerzos (Nervi, 1965).

La solucion formal, una vez liberada de los encofrados de madera con el
ferrocemento, respeta los principios que rigen la solucion estructural. <’La distribucion de
esfuerzos en un sistema hiperestatico [...] es un modelo perfecto de justicia y distribucion
econdmica’’(Nervi, 1945, p. 5-9). Economia como sinénimo de honestidad intelectual,
tener que utilizar de la forma méas conveniente los recursos de los materiales y los métodos
de construccion. El “’Sistema Nervi’’ aseguraba la correspondencia entre decisiones
estructurales y procedimiento constructivo, el cual era remarcablemente econémico
(Desideri, Nervi y Positano, 1982; Poretti, 2010).

Desde que la forma debia expresar la economia de la solucion estructural, la
intuicion estatica debia estar presente desde la primera idea de disefio. Nervi insta sobre
el hecho de que los céalculos matematicos de la teoria estructural solo pueden utilizarse
para analizar una estructura ya disefiada. La base del disefio, donde quedan definidas sus
principales caracteristicas, no puede servirse solo de la teoria de estructuras y ha de
depender de la simplificacion intuitiva. Las obras de Pier Luigi Nervi no comienzan con
formulas, es aqui donde el papel de la sensibilidad estética tiende un puente entre la
intuicion personal sobre las estructuras y el conocimiento cientifico acerca de ellas
(Huxtable, 1966; Salvadori y Heller, 1976). Nervi indica como sensibilidad estatica: “’El
hecho de idear un sistema resistente es un acto creativo que se basa, solo en parte, en
datos cientificos; la sensibilidad estatica que lo determina, queda como la sensibilidad
estética, como una capacidad puramente personal, o mejor dicho, el fruto de la
compresion y de la asimilacion, llevado a cabo en el espiritu del proyectista, de las leyes
del mundo fisico’” (Nervi, 1945, p.21).
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En su libro “Aesthetics and Technology in Building’’ (1965), busca una relacion
entre la estética de la arquitectura y la tecnologia de construccion. Tras examinar durante
afios las obras de arquitectura del pasado y del presente desde el punto de vista
constructivo, Nervi (1972) llega a la conclusion de que las obras técnicas perfectas pueden
ser inexpresivas, pero que no existe, ni en el pasado ni en el presente, obras
arquitectonicas que no sean aceptadas y reconocidas desde el punto de vista estético que
no sean al mismo tiempo excelentes desde el punto de vista técnico. En el pasado, la
construccidn se guiaba exclusivamente por intuiciones estaticas, fruto de la experiencia y
del modo en que lo materiales resisten las fuerzas.

Para Nervi, toda estructura en hormigén armado constituye un organismo en el
que las tensiones se propagan y transmiten de unos nervios a otros, convirtiéndose el
hormigon en la visible materializacion del juego de fuerzas que se producen (Abram,
2010; lori, 2009). Nervi se apoya en la conviccion de que seguir a las leyes de la estatica
es de por si garantia de éxito estético, asi, modelando las estructuras segun las fuerzas en
el espacio, consigue formas arménicas y expresivas (Desideri, Nervi y Positano, 1982).
Segun Nervi (1942), las leyes de la naturaleza son la més sincera guia que pueda
determinar una construccién. Nervi pretende crear organismos estructurales que
respondan a las leyes de la estatica (Huxtable, 1966).

La expresion de lo resistente encuentra su representacion en la “’teoria de la
empatia estética’> de Theodor Lipps (1851-1914) que ha influido en ingenieros como
Nervi, Eduardo Torroja, Fernandez Casado, Félix Candela y Antonio Gaudi (Néardiz,
2017). Lipps explica por qué encontramos expresion ain en objetos inanimados, como es
el caso que ejemplifica sobre las columnas, donde al mirarlas sabe por su experiencia
pasada la clase de presidn y contrapresion mecanicas que acttan sobre ellas. Segun esta
teoria la simple contemplacion de la columna es suficiente para que la mente experimente
los sentidos relativos a la distribucion de cargas en base a experiencias pasadas (Arnheim,
1991). Del simil organicista han participado todos los estructuristas, donde el
comportamiento de los seres vivos con sus estructuras internas se convierten en modelos
de las estructuras creadas por el hombre (Cardellach, 1970). Resulta curioso hacer la
comparacion de dos citas sobre este simil organicista. La primera es de Alberti, que
afirma: “’..en toda clase de bovedas, hemos de intentar imitar a la Naturaleza, la cual
después de unir huesos, sujeta la carne con nervios, entrelazandola por todas partes con
ligamientos que van a lo ancho, a lo largo, a lo alto y circularmente’’ (Huxtable, 1966,

p.19). La segunda es de Nervi y trata sobre el refuerzo del cemento: ‘’La norma de acero
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

deberia tener una cualidad estética y dar la impresion de ser un sistema nervioso capaz de
infundir vida a la masa inerte del cemento’’ (Nervi, 1956, p.39).

El carécter de la arquitectura de Nervi recae en la minuciosa superficie ondulante
y en el denso tejido de nervios que configura bovedas, cupulas y forjados. Estos patrones,
aunque dispongan de riqueza decorativa, responden fielmente el flujo de tensiones de la
estructura (Poretti, 2010).
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ura 12: Intradds cupula del Palazzetto dello Sport. Fuente: lori, 2009.
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1.3.4. EXPERIMENTACION EN MODELOS

El uso de modelos para el ensayo en laboratorio de estructuras en hormigon
armado se desarrollé en Europa entre 1935 y 1936, casi contempordneamente por Nervi
(en colaboracién con el Politécnico de Milan) y por el ingeniero Eduardo Torroja (en el
Instituto Técnico de la Construccion y del cemento, que él mismo ayudo a fundar, asi
como en el Laboratorio Central de Estructuras y Materiales de la Escuela de Ingenieros
de Caminos) (Arredondo et al., 1977). Los laboratorios de Madrid y de Milan son los
primeros que utilizan esta técnica para reproducir fielmente, a escala reducida y con
materiales apropiados, el comportamiento estatico y verificar la resistencia para el
dimensionado de estructuras complejas, donde los calculos previos simplificados no eran
suficientes (Huxtable, 1966).

Para conseguir la perfecta correspondencia entre el modelo y la estructura real era
necesario un estudio profundo tanto del campo teérico como del préactico. Las bases para
la experimentaciéon en modelos se asentaron en el laboratorio ‘’Prove Modelli e
Costruzioni’’, junto al Instituto de Ciencia de la Construccion del Politécnico de Milén,
creado por el profesor e ingeniero Arturo Danusso hacia 1930 (Danusso y Oberti, 1941),
y con la experiencia de la actividad continua e intensa del profesor Guido Oberti que en
1936 habia establecido las bases tedricas para la construccion y uso de modelos

estructurales, definiendo las caracteristicas de los materiales y ensayos (Oberti, 1956).

La primera colaboracion entre Oberti y Nervi empez6 en 1935 con la
experimentacion en modelos para la serie de hangares en Orvieto (1935-38),
posteriormente en Orbetello (1939-42) y Torre del Lago (Oberti, 1980). Esta colaboracion
da un impulso nuevo y decisivo al campo de la experimentacién en modelos y mas
intensamente al ISMES, centro de experimentacion en modelos creado después de la
guerra. Torroja utilizé modelos a gran escala (1:10) y materiales similares a los de la
construccién real para el analisis de su Fronton de Recoletos. Los modelos para los
hangares, sin embargo, fueron construidos a una menor escala (1:37) y con celulosa,
analizando solo el campo elastico de peso muerto y viento. Las razones de esta menor
escala eran las extensas dimensiones de 110 x 36 m en planta. Para un analisis mas alla
de los efectos elasticos se hubiera requerido un modelo a mayor escala. Los efectos de la
escala ya se plantaban por Leonardo da Vinci y Galileo (Chiorino, 2010). No obstante,

segun Oberti, Nervi contribuye de manera critica en la experimentacion, introduciendo
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las caracteristicas singulares de cada proyecto, como la cimentacion, articulaciones o
procesos constructivos, con gran atencion a la equivalencia de esfuerzos y materiales
(lori, 2009). Esto remarca la capacidad de disefio estructural y gran sensibilidad estatica

de Nervi.

En la segunda mitad de la década de 1960, el ISMES experimenté un nimero
importante de proyectos en USA 'y Europa. En 1967 se analizd, con dos modelos a escalas
1:50 y 1:100, el Centro Cultural en Norfolk, Virginia, que presentaba algunas de las
soluciones constructivas adoptadas para el Palazzetto dello Sport en Roma pero a una
escala mayor con su clpula de 135m (Chiorino, 2010). La obra de Nervi y su
experimentacion en el ISMES le daria a este centro reconocimiento mundial, siendo su
nombre signo de garantia. Nervi, mediante la experimentacion en modelos, consigue
eliminar los limites de la construccion, poniendo de manifiesto su creatividad (Nervi,
1965).

Figura 13: Modelo de celulosa para la segunda serie de hangares. Fuente: Olmo y Chiorino, 2010.

1.4.0OBRAS SIGNIFICATIVAS Y LA ARQUITECTURA DEL DEPORTE
EN LA CARRERA DE PIER LUIGI NERVI

Desde la construccion del estadio municipal Giovanni Berta de Florencia (1929-
32) hasta la del Kuwait Sport Center (1968-69), pasando por los XV1I Juegos Olimpicos
de 1960, la arquitectura del deporte ha sido una constante en la carrera profesional de Pier
Luigi Nervi (Antonucci, Trentin y Trombetti, 2016).

En la construccion del estadio Berta, Nervi encontrd dos problemas que guiarian
el curso de la experimentacion en su carrera: la dificultad para realizar calculos exactos
sobre el comportamiento del hormigon y la falta de adaptabilidad a las superficies curvas

de los encofrados de madera (Cimet, 1964).
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Figura 14: Escalera del Estadio Berta. Fuente: lori, 2009.

Al éxito del estadio Berta, le siguen proyectos innovadores como el hotel flotante
(con R. Magnani, 1932-33), la casa giratoria (1934) y la segunda serie de hangares.
Después de la Segunda Guerra Mundial, con su compafia Nervi e Bartoli, realiza una
serie de trabajos con su ‘Sistema Nervi’: el Salone B (1947-49) y la Exposicion C (1950)
de la Exposicion de Turin, la fabrica de tabaco en Bolonia (1951-52), el Palazzo del
Lavoro en Turin (con Gino Covre, 1959-61) y las instalaciones para las Olimpiadas (el
Palazzetto dello Sport con A. Vitellozzi; Palazzo dello Sport con M. Piacentini; el estadio
Flaminio con A. Nervi y el Viaduct de Corso Francia) que le hacen ganar el Royal Gold
Medal, el cual en los afios anteriores fue concedido a arquitectos como Le Corbusier,
Walter Gropius, Alvar Alto y Mies Van der Rohe (lori, 2009; Antonucci, Trentin y
Trombetti, 2016).

El aumento de su fama a nivel mundial coincide con la fundacion de su Estudio
Nervi en la década de 1950, realizando proyectos como la Sede de la UNESCO en Paris
(con M. Breuer y B. Zehrfuss, 1952-58), la Estacién de autobuses en Nueva York (1960-
62), el rascacielos Place Victoria en Montreal (proyecto L. Moretti, 1962-66), la Sala de
audiencias en el Vaticano (1964-71) o la Catedral de Santa Maria en San Francisco (con
P. Belluschi, proyecto Mc Sweeney, Ryan y Lee, 1966-71) (Antonucci, Trentin y
Trombetti, 2016).
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Tras el enorme éxito internacional de las obras para los Juegos Olimpicos, se le
encargan instalaciones deportivas en todo el mundo, tales como la Arena at Darmouth
College en Hannover (con A. Nervi), el Sports Hall en Norfolk, Virginia (con Williams
& Tazewell) o el Good Hope Centre en Ciudad del Cabo (con A. Nervi) (lori, 2009).

1.5.EL PALAZZETTO DELLO SPORT EN ROMA (1957)

El Palazzetto dello Sport, ubicado en el distrito de Flaminio de Roma, es un
edificio emblemaético de los afios de la posguerra de Pier Luigi Nervi, en los cuales destaca
su experimentacion con el ferrocemento y la prefabricacion de elementos estructurales
(Poretti, 2008). Este trabajo culmina en su larga trayectoria profesional el éxito estatico,
constructivo, economico y arquitectonico del ‘Sistema Nervi’: costo tan solo 200 millones
de liras (265 incluyendo las instalaciones técnicas), fue construido en poco méas de un
afio, fue celebrado en revistas de tecnologia y arquitectura de todo el mundo y el
arquitecto recibié los mas prestigiosos premios en el area internacional, como el Royal
Gold Medal (en los afios anteriores fue concedido a arquitectos como Le Corbusier,
Walter Gropius, Alvar Alto y Mies Van der Rohe) (lori, 2009; lori, 2017).

La estructura no fue concebida para acoger los Juegos Olimpicos de 1960, donde
el edificio obtuvo fama. En un primer momento se trataba de un prototipo econémico
para complejos de deporte de tamafio mediano, que pretendia construirse de manera
idéntica en todas las ciudades de Italia con una capacidad para 4000-5000 espectadores
dependiendo del tipo de competicion (Cuadernos de la Arquitectura, 1958; Bauen +
Wohnen, 1960; Veresani y Visconti, 1994; lori, 2009; lori, 2010). La Comision Olimpica
Nacional Italiana (CONI) asigné el proyecto al arquitecto Annibale Vitellozzi, quien
busco la colaboracion de Pier Luigi Nervi para encontrar la solucion econémica 6ptima
para una cubierta de grandes luces. Los sistemas, accesorios y acabados tanto interiores
como exteriores se restringieron a los minimos necesarios (lori, 2009; lori, 2010).

El disefio, que juntos proyectaron, se trataba de una cupula esférica de 59,20 m de
diametro, rebajada con 10 m de flecha y apoyada a la altura de la imposta sobre 36 pilares
inclinados a modo de caballetes bifurcados, ordenados sobre una circunferencia de 78
metros de didmetro a cada 10 grados (Cuadernos de la Arquitectura, 1958; Ugarte, 1958;
Desideri, Nervi y Positano, 1982; lori, 2009; lori, 2010). La arena se encuentra por debajo
del nivel de planta baja, rodeada por gradas curvas. Los servicios se situan en el anillo

perimetral entre los pilares y bajo las terrazas (algunos estan situados en el sotano,
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parcialmente excavado). La cupula nervada se proyectd desde un primer momento con el
“’Sistema Nervi’’ de elementos prefabricados, mucho mas barato que los sistemas
tradicionales (lori, 2009; lori, 2010).

La primera aplicacion del prototipo fue en Roma: el 20 de febrero de 1954 el
consejo ejecutivo del CONI hablaba de la construccidn de un centro de deportes en la Via
Flaminia y el 13 de abril la Comisién para instalaciones deportivas aprobo el proyecto.
Esto fue con anterioridad a que Roma fuera elegida para los XVII Juegos Olimpicos el
15 de junio de 1955, aunque por supuesto, la oferta de Roma para los juegos estaba
respaldada por este prototipo. EI comité técnico, Costruzioni Olimpiche Roma (COR) el
15 de abril de 1955 presupuesta la suma necesaria para la instalacion con 150 millones de
liras y una reserva de otros 50 millones por si fuera necesario (en la fase inicial, Nervi
habia presupuestado 138 millones solo para la estructura), y se aprueba el proyecto
definitivo (lori, 2009; lori, 2010).

Después de que los juegos fueran concedidos a Roma, el Palazzetto perdi6
prioridad para el COR, ya que tenian que organizar muchos otros edificios para que el
evento pudiera tener lugar en la capital italiana. Nervi disefio y construyo algunos de los
otros proyectos para las Olimpiadas (El Complejo de Deportes de EUR in Rome con
Marcello Piacentini, el Estadio Flaminio con su hijo Antonio y el viaducto en Corso
Francia dentro de la ciudad de los atletas), a pesar de que no tuvo éxito en otros concursos
(para el disefio del velédromo y la terminal de Fiumicino) (lori, 2010).

Mientras tanto, el 21 de Julio de 1955 el ayuntamiento de la ciudad concede el
solar (lori, 2010), con una simple resolucion del alcalde sin pasar por el cambio de
planeamiento de la ciudad, ya que en esa ubicacion estaba destinada a zona verde; ademas
hubo que desalojar un campo de refugiados equipado inmediatamente después de la
guerra. Resuelta la adjudicacion del solar, se realizan estudios geotécnicos hasta la
profundidad de 10 metros que desvelan una capa de arcilla pura y grava. Nervi disefia la
cimentacion de tipo superficial (lori, 2009), un anillo continuo de 81,5 m de didmetro,
2,5 m de ancho y 40 cm de espesor (Ugarte, 1958; Bauen + Wohnen, 1960; Desideri,
Nervi y Positano, 1979) capaz de absorber el esfuerzo de la clpula a través de cables
postesados envainados, anclados a la base de 6 de los 36 soportes usando el tipico sistema
de cono de Freyssinet (lori, 2010), una de las pocas aplicaciones del postesado en las
obras de Nervi (Nardiz, 2017).

El coste estimado para la fase de cimientos no dejaba excedentes, y, debido a que

el proyecto se habia disefiado con el “’Sistema Nervi’’ y a la inexistencia de ninglin otro
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proceso ni patente que se ajustase al precio y a los plazos, la asignacion de la totalidad de
la obra tuvo que darse por negociacion privada a los Unicos titulares de la patente, la
compafiia Nervi e Bartoli. La adjudicacion del proyecto por el COR tuvo lugar en agosto
de 1956 con un presupuesto de 200 millones de liras (en comparacion con el presupuesto
inicial de 160 millones de liras, incluidos los cimientos y los honorarios). Fue el proyecto
registrado con n°3870 de la compafiia, desde la concesion del solar transcurren 420 dias
para completar su construccion bajo la supervision de Giacomo Maccagno, técnico
municipal (lori, 2009; lori, 2010).

En la primera fase se ejecutd la cimentacion y los 36 caballetes de forma
antropomorfica mediante unos pocos encofrados que se reutilizaban en cada soporte a
modo de prefabricado. Estos representan la figura de hombres con los brazos extendidos,
con una pierna doblada y la otra apuntada hacia atrés para contrarrestar el empuje de la
cUpula. Al mismo tiempo, junto a la obra, se habia dispuesto un almacén donde ejecutar
los prefabricados de ferrocemento (lori, 2009; Nardiz, 2017).

Nervi utilizé el proceso que venia utilizando desde el cobertizo en Torre in Pietra
y la segunda serie de hangares de Orvieto, a través del cual la ctpula se dividia en piezas
prefabricadas de ferrocemento para ser ensambladas en el sitio, formando, al verter el
hormigon, una estructura monolitica. Se elaboraron 13 piezas distintas, ‘tavelloni’ o
piezas huecas, como se llamaban en la patente de 1950. Las piezas (triangulares,
romboides o alargadas en el caso del éculo central) se dimensionaron para poder ser
fabricadas y transportadas por dos operarios a mano (lori, 2009).

La misma técnica ya habia sido utilizada en el Hall B de Turin, que se trataba de
una cupula similar, pero a una escala mayor; respaldado por su analisis, Nervi prescindio
de la experimentacion en modelos para el caso del Palazzetto (lori, 2009).

El ferrocemento utilizado, con sutiles diferencias respecto a su patente de 1943,
estaba compuesto por una rejilla de armadura de 6mm dispuesta cada 15cm con
superposicién de malla de 0,6 kg/m2 (Ugarte, 1958; Bauen + Wohnen, 1960; lori, 2010).
El cemento de aridos finos configuraba un espesor de 2,5 cm. Con la prefabricacion
artesanal, dividida en pasos secuenciales, el proceso resulté muy econdémico, se
ejecutaban méas de 30 piezas de ferrocemento al dia. Primero se construyd un segmento
de la cupula a escala real con madera, sobre él se dibujaron y realizaron los ejes de los
nervios con mamposteria y se recubrié todo con yeso; sobre ella con ferrocemento se
elaboraron 13 moldes. Estos primeros, llamados ‘abuelas’ segiin la verba de la obra,

voltedndolos sirvieron para alojar a un determinado ntimero de ‘madres’ que resultaban
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idénticas a los moldes de mamposteria, usando estas ultimas se realizaron decenas de
‘hijas’ idénticas a las abuelas que finalmente conformaban la cupula (Iori, 2009; Iori,
2010).

En diciembre de 1956, las 1620 piezas prefabricadas estaban listas, apiladas y
numeradas, organizadas en 13 tipos. Gracias al ferrocemento y la no necesidad de
encofrados de madera se pudo utilizar un sistema de andamiaje ligero tubular. Una vez
dispuestas las piezas en su posicion definitiva, con la ayuda de una gria que operaba
desde el oculo, se hormigona en los canales que habian conformado los nervios de
mamposteria y se vierte una capa de hormigon de 3 cm reforzada con malla metélica
sobre toda la clpula, asi el mosaico queda ensamblado y formando un todo monolitico
por las conexiones de las armaduras del ferrocemento con los nervios. El prefabricado de
ferrocemento, que actla de encofrado perdido, esta perfectamente terminado por el
intradds, listo para quedar visto y conformar la expresividad de la obra y su sinceridad
constructiva (Ugarte, 1958; Desideri, Nervi y Positano, 1982; lori, 2009).

La cupula se termind en tan solo 30 dias: al final de febrero el andamiaje se
retiraba y los trabajos de tabiqueria interior y acabados se terminaban. Sobre la clpula se
vierte una capa aislante de 5cm de vermiculita, seguida de una capa de Bitragar y arena
para sostener las capas impermeabilizantes de vetroflex y asfalto, finalmente se le da un
acabado de pintura bituminosa gris, la cual requiere mantenimiento y explicaria la
apariencia descuidada de la obra hoy en dia (lori, 2010).

El 14 de septiembre se firma el final de obra en cumplimiento de los términos del
contrato, realizdndose la prueba de cargas el 30 de septiembre (lori, 2010). La
deformacion eléstica del anillo de cimentacion fue de un aumento del radio en 5 mm,
coincidiendo exactamente con los calculos previstos (Ugarte, 1958). El 6 de octubre, con

el partido de baloncesto entre Italia y Checoslovaquia, la vida deportiva del Palazzetto

comenzaba (lori, 2010).
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Figura 16: Secuencia constructiva de los prefabricados de ferrocemento. Fuente: lori, 2009.

Figura 17: Palazzetto dello Sport en Roma. Recuperado de: https://n9.cl/2y6d.

Los alzados, las secciones y las plantas, asi como detalles constructivos e
imagenes que han permitido contrastar la informacion y realizar el modelo se adjuntan en
los anexos (pp. 110-113).
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2. ANTECEDENTES EN LA INVESTIGACION DE LA
ESTRUCTURA DEL “PALAZZETTO DELLO SPORT”

Tras una buasqueda bibliografica, la investigacion encontrada acerca de la
estructura del Palazzetto previa a este trabajo se dirige a la realizacion de modelos a escala
reducida.

Con motivo del proyecto "Pier Luigi Nervi. Architettura come Sfida™, un proyecto
expositivo itinerante dirigido por Carlo Olmo, que estuvo en Bruselas, Venecia y Roma,
entre 2010 y 2011, se elaboraron diferentes modelos de sus obras mas significativas, en
especial de las realizadas para los Juegos Olimpicos de 1960 (Nervi et al., 2011).

En este contexto, la contribucion del NerViLab (Nervi Virtual Lab), grupo de
investigacion del Departamento de Ingenieria Estructural y Geotécnica de la Universidad
Sapienza en Roma, fue analizar y representar los aspectos estructurales, geométricos,
formales y constructivos de algunas de las obras seleccionadas para el proyecto expositivo
(Nervi et al., 2011).

Para representar y analizar la sintesis nerviana entre composicion estructural,
forma geométrica y construccidn, el NerViLab primero realizaba el modelado
matematico tridimensional de las diferentes obras, que posteriormente se imprimia en una
impresora 3D de estereolitografia. Una vez impresos, para facilitar la interpretacion
correcta de los componentes arquitecténicos, se insertaron elementos de materiales
tradicionales como madera, policarbonato y metacrilato. El uso de esta tecnologia
permitid crear réplicas exactas de las obras de Nervi a escala reducida, como es el caso
del Palazzetto, elaborado a escala 1:50 (Nervi et al., 2011; Casale y Rossi, 2014).

Paralelamente, pero unicamente para la exposicion de este itinerario realizada en
el Museo MAXXI de Roma, el laboratorio de este museo, el SIXXI3DLab, elaboré otro
modelo del Palazzetto. Este modelo, disefiado por lori y Poretti y construido por Sergiusti
y Giudice, reproduce una cuarta del Palazzetto, para optimizar los costos, pero a gran
escala (1:25). Tiene 3,6 metros de didmetro y las piezas romboidales del Palazzetto, de
2,5 cm de grosor en el original, se hacen con laminas de poliestireno de 1 milimetro,
cortadas con una maquina CNC (Control Numérico Computarizado). Todo el proceso de
construccion del modelo tuvo lugar repitiendo la secuencia de ejecucion real, por
supuesto, adaptando dicho proceso a las tecnologias disponibles y a la escala reducida
(lori, 2017; Capurso y Giannetti, 2019).
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Posteriormente, en 2016 y con motivo de una nueva exposicion realizada en el
MAXXI, denominada “In Contatto con Nervi”, se cred otro modelo del Palazzeto, a
escala 1:300. Los encargados de la elaboracion del mismo fueron dos estudiantes del
Instituto Superior de Industrias Artisticas, Aureliano Capri y Elettra Renzi. En este caso,
la exposicion pretendia llegar también a la gente con discapacidad visual, por lo que este
modelo representa una version facilmente comprensible del edificio y tacticamente

explorable por todos (Antonucci, Trentin y Trombetti, 2016).

3. OBJETIVOS

Los objetivos de este Trabajo Final de Grado son:
- Realizar un modelo geométrico en Autocad para su importacion a SAP2000.
- Definir en este modelo idealizado las secciones y materiales que se han

extraido de las fuentes bibliograficas.

- Simplificar para el modelo idealizado las coacciones externas en los apoyos.
- Evaluar las acciones a las que esta sometido el edificio segiin el CTE-DBSE.
- Asignar dichas acciones al modelo.
- Formular las combinaciones de acciones para el calculo de la estructura.
- Calcular la estructura con el programa SAP2000 v20.2.0.
- Comprobar el cumplimiento de los Estados Limite de Servicio (ELS).
- Comprobar el cumplimiento de los Estados Limite Ultimos (ELU).

- Extraer conclusiones sobre el comportamiento de la estructura.
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BLOQUE 2: ANALISIS DE LA ESTRUCTURA DEL
“PALAZZETTO DELLO SPORT”’

En este segundo bloque se analizard el comportamiento de la estructura del
“‘Palazzetto dello Sport’” con el programa SAP2000 Version 20.2.0, en base a las
exigencias de la normativa vigente del CTE aunque atendiendo a la normativa italiana
NTC 2018 cuando se deban conocer parametros de caracter dependiente geografico. Para
realizar el modelo geométrico de la estructura se ha utilizado el software Autocad 2019.

Los datos que no se han podido obtener de la resefia bibliografica y documental
sobre el edificio se han simplificado. EI primero es el tipo de acero que se utiliz6 en obra
(que se ha adoptado un acero fyx = 400MPa), el segundo es la fuerza de postensado de los
cables de la cimentacion (que se ha deducido a partir de la deformacion horizontal del
anillo que si era dato conocido).

La simplificacion del modelo de analisis consiste en modelizar solamente la
cubierta conformada por la ctpula y los 36 soportes antropomorficos que la sostienen, asi
como el anillo de cimentacién. Por tanto, se ha obviado el sistema interior de semisotanos
y de graderio, que si bien forma parte del edificio no se unen al mismo estructuralmente.
Resulta adecuado hacer esta simplificacidn teniendo en cuenta que el propio Nervi (1965)
afirmaba que la caracteristica fundamental del Palazzetto era la independencia completa
de la clpula respecto de las gradas y servicios inferiores.

Se evaluard la seguridad, estabilidad y funcionalidad del modelo segun la
normativa del CTE (DB-SE, DB-SE-AE, NCSE-02 y EHE-08). Cuando, para la
evaluacion de acciones, sea necesario obtener datos de caracter geografico o
climatoldgico se acudira a la normativa italiana NTC 2018. El objetivo es comprobar si
la estructura del Palazzetto dello Sport se adecua a las exigencias de deformaciones y
resistencias Ultimas del CTE, asi como comparar los resultados de la deformada
horizontal del anillo de cimentacién que se obtuvieron en la obra real con el modelo en
SAP2000.

Se admiten las siguientes hipétesis basicas:

1. EIl agotamiento se produce cuando en la seccidn se alcanzan determinadas

deformaciones. Las deformaciones limite en agotamiento son (signo positivo
en traccion y negativo en compresion): en el acero traccionado, s < 10,0%o, y

en el hormigon, 10,0%o0 > ec > -3,5%o0 desde que la seccion estd uniformemente
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traccionada (x=-o0) hasta que toda la seccion estd comprimida por primera vez
(x=h), y -2,0%0 > ec > -3,5%o a partir de ese momento.

2. Las secciones de hormigon permanecen planas después de la deformacion
aceptando la hipotesis de Bernoulli.

3. Existe compatibilidad de deformaciones entre acero y hormigoén.

4. No se considera la resistencia a traccion del hormigon.

5. Se adoptan diagramas simplificados de calculo tension-deformacion tanto

para el acero (elastoplastico) como para el hormigon (parabola-rectangulo).

Para que una seccion de hormigon armado sometida a esfuerzos exteriores no
colapse, estos esfuerzos deben de estar en equilibrio con la resultante de las tensiones en
el material. El equilibrio se establece aplicando las ecuaciones de equilibrio estatico de

fuerzas Yy momentos.

Ademas, el anélisis estructural se realiza sobre un modelo de la geometria
idealizado, donde se estudia una aproximacion a las acciones, a las condiciones de enlace

y al comportamiento de la estructura.
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4. MODELO GEOMETRICO EN AUTOCAD

El modelo geométrico esta dibujado con Autocad 2019 de Autodesk. De las

diversas fuentes bibliograficas que se encuentran al final de este trabajo (principalmente

revistas técnicas contemporaneas a la obra), se extraen los siguientes datos:

DATOS

SE DESCONOCE

Cimentacion

Superficial.

Anillo de 81,5 m de diametro a eje.

2,5 m de ancho.

40 cm de espesor generalmente, pero
recrecida a 80 cm cada 6/36 soportes.
Postesada mediante 14 cables (12 @7)
repartidos en sus caras superior e inferior.
Sistema de cono Freyssinet para el
postesado.

HA-14

Tension de postesado.
Tipo de acero.

Soportes en
£9Y’9

36 caballetes en Y ordenados a cada 10 °.
Inclinados segun la tangente a la curva de la
ctpula en el plano de la imposta.

Apoyados sobre el suelo sobre
circunferencia de 78 m.

Prolongados bajo el suelo hasta conectar con
la cimentacion.

Armado.

HA-14

Tipo de acero.

Cupula

Formada por 1620 elementos prefabricados.
Diametro en la imposta de 59,2 m.

Altura en la clave de 21 m desde la arena.
10 m de flecha.

Espesor medio de 12 cm.

13 tipos de elementos prefabricados

de 2,5 cm de espesor.

Capa de vermiculita de 5 cm de espesor
sobre ella, ademas de impermeabilizacion.
Armado de los prefabricados.

HA-14

Tipo de acero.

Tabla 1: Datos del Palazzetto para la realizacion del modelo. Fuente: elaboracién propia.

Los elementos que componen la geometria se han dibujado mediante los

comandos “’LINEA”’ (elementos donde prima la longitud: soportes en “’Y’’, nervios,

cables postesados) y ’3DCARA”’’ (elementos donde el espesor es muy inferior a las otras

dos dimensiones: 13 tipos de elementos prefabricados, cimentacion).
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

La cupula esta formada por 1620 elementos prefabricados de ferrocemento de
forma romboidal, a excepcion del perimetro de la imposta que se realiza con piezas
triangulares y del 6culo central que se ejecuta con piezas alargadas trapezoidales. Con el
modelado mediante 3dcaras romboidales planas, se consigue un tronco de cono. Pese a
no ser la geometria deseada nos proporciona, conociendo el didametro de la ctpula en la
base, una progresion del tamafio de los 13 elementos prefabricados mucho mas exacta
que cualquier calco de planimetria.

pem—-

Figuras 18 y 19: Alzado y planta en Autocad del modelo con 3dcaras romboidales. Fuente:
elaboracion propia.
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

Teniendo ya una planta donde se definen con exacta precision las intersecciones
de los nervios, realizando un levantamiento hasta la interseccion con el perfil del casquete
esférico, conseguimos la discretizacion de los romboides en formas triangulares,
permitiendo la configuracion de doble curvatura para conformar el casquete esférico, es
decir, la clpula.

// i sV i eV s &Y R & .
Y.+ rfp"" f%i?g AR “kwt, s TR
/ “ ‘w**“x»—f--~r911—4=‘1 fjr'x‘f‘ﬁﬁlﬁ"‘

7 A

7
\ Ik

Z

Figuras 20y 21: Alzado y planta en Autocad del modelo con 3dcaras triangulares. Fuente:
elaboracion propia.
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Los soportes se dibujan inclinados, tangentes a la curvatura de la cipula a la altura
de la imposta, conociendo sus puntos iniciales y finales. Siguiendo esta inclinacion se
dibujan para partir de su inicio en una circunferencia de 78 m hasta otra concéntrica de
59,2 m (diametro de la cupula a la altura de la imposta), conociendo ya los puntos de la
cUpula donde se uniré la bifurcacion. Cada soporte se repite a cada 10°, hasta conformar

los 36 soportes.

La cimentacion, se dibuja con 3dcaras atendiendo a las dimensiones reflejadas en
los planos de detalle a escala 1:10 de las fuentes bibliograficas. Se discretiza la superficie
creando un anillo, que forma una especie de corona de caras rectas, aproximandose a la
configuracién de caras curvas, que no se pueden realizar con 3dcaras. Se ha previsto la
subdivision para localizar los cables de postesado y para diferenciar los recrecidos de
espesor (de 40 cm a 80 cm en 6/36 soportes). Con la misma inclinacion de los soportes

estos se prolongan hasta su interseccién con la cimentacion.

Figura 22: Planta de la cimentacion y soportes del modelo en Autocad . Fuente: elaboracion propia.
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El modelo geométrico de la cupulay los pilares se ha dibujado de manera analoga
al procedimiento constructivo que se realizé en la obra (se construy6 una montea a escala
real de 1/36 de la cupula para la prefabricacion de los elementos de ferrocemento). Se ha
modelado el sector correspondiente a 1/36 de la cUpula para después ejecutar la orden
“MATRIZRADIAL’, guardando precaucion de la no duplicidad de nervios. La
cimentacion se ha dibujado de manera similar, pero atendiendo a la discontinuidad que
representan los recrecidos a cada 6 soportes. EI sombrerete superior (también de
hormigon pero sustentado por perfiles metélicos) se ha dibujado discretizando la
superficie en 3dcaras triangulares y con lineas para la formacion de los nervios y

conectores a la ctpula.

El resultado final del modelo en Autocad 2019 es el que sigue:

Figura 23: Modelo final en Autocad 2019. Fuente: elaboracion propia.
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5. IMPORTACION DEL MODELO A SAP 2000 V.20.2.0

Con el modelo de Autocad terminado se genera un archivo *’.dxf”’. Para ello,
previamente se ha cargado en Autocad una aplicacion desarrollada por David Gallardo,
que orienta de manera adecuada todos los ejes locales de barras y 3dcaras (que por defecto
se dibujan siguiendo la “’regla de la mano derecha’’) y exporta en dicho formato en la

misma ubicacion del archivo “.cad’’.

5.1.IMPORTACION Y DEFINICION DE GRUPOS

La importacion se realiza desde File>Import>AutoCAD .dxf File. Seleccionando
nuestro archivo ’.dxf’ se abre un cuadro de didlogo que nos permite importar por
distintas categorias, distinguiendo entre Frames (lineas) y Shells (3dcaras). Se debe elegir

la direccion del eje global z asi como las unidades.

:X: Impoert Information s ¢ DXF Import x
Assign Layers
Global Up Directicn

O X O v @ = Special Joints. NONE ~

O 'S O Y o 7 Frames NONE ~
NL Links NONE ~
Shels NONE ~

Units KN, m, C v
Solid NONE ~

oK Cancel

Figuras 24 y 25: MenUs de importacion en SAP2000. Fuente: elaboracién propia.

En el menu Define>Groups, podemos afiadir tantos grupos de seleccion como
qgueramos. No tiene por qué depender del nimero de capas importadas, ya que una misma
capa puede pertenecer a varios grupos o a ninguno. Es importante recordar el orden de
importacion para que desde el menu de Define Group Names se pueda cambiar el nombre

por defecto o crear nuevos grupos.

3¢ Define Group Names *

Groups Click to:

" GEEL T ELY
_Casquete Frames

_Casquete Montantes Modify/Show Group...
_Casquete Nervios

_Casquete shells

_Casquete travesanos

_Cimentacion frames

_Cimentacion Shells Delete Group
_Cimentacion_Anclajes

_Cdpula Nervios

_Ciipula shells oK

Cancel

Figura 26: Menu de definicion de grupos en SAP2000. Fuente: elaboracion propia.
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Creando los grupos acertadamente tendremos gran libertad para seleccionar los

elementos de nuestro modelo desde Select>Select>Group o Ctrl+G. Estos son algunos de

los grupos creados en el modelo del Palazzetto:

B Select by Groups X

Filter

Groups
_CablesPST
_Casguete Frames
_Casguete Montantes
_Casguete Nervios
_Casguete shells
_Casguete travesafios
_Cimentacién_Anclajes
_Cimentacién frames
_Cimentacion Shells
_Cdpula Nervios
_Cdpula shells
_soportes verticalesy
_SoportesY
_SoportesY_inferior

SoportesY pies

| Select | |Dese|ect| | Close |

Figura 27: Menu de seleccion por grupos en SAP2000. Fuente: elaboracién propia.

5.2.DEFINICION DE MATERIALES

El hormigon utilizado fue un HA-14. El tipo de acero empleado se desconoce tanto

para el armado genérico como para el postensado. Debido a esto, se considera para las

armaduras un acero B 400 SD.

Las caracteristicas del HA-14 son:

Resistencia a compresion caracteristica fo= 14N/mm?,

Peso especifico = 24,5kN/m?.

Coeficiente de Poisson= 0,2 (EHE-art. 39.9).

Coeficiente de dilatacion térmica= 1x10° (EHE-art. 39.10).
Modulo de deformacion secante: 23817,334 MPa (EHE-art. 39.6).

Las caracteristicas del acero B 400 SD son:

Resistencia a traccion caracteristica fyx= 400N/mm?. (EHE-art.32.2).
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Desde el mena Define>Materials, definimos los materiales que vamos a emplear:

HA-14 y acero para postesado Y 1860 C.

B Material Property Data

General Data
Material Name and Display Color
Material Type
Material Grade

Material Motes

VWeight and Mass
Weight per Unit Volume: 245

Mass per Unit Volume 2,4983

Isotropic Property Data
Modulus Of Elasticity, E
Poisson, U
Coefficient Of Thermal Expansion, A

Shear Modulus, G

Other Properties For Concrete Materials
Specified Concrete Compressive Strength
Expected Concrete Compressive Strength

[] Lightweight Concrste

D Switch To Advanced Property Display

HA-14

Concrets

|

Modify/Show Notes.

, fc

Cancel

Figuras 28 y 29: Menus de definicion de materiales en SAP2000. Fuente: elaboracion propia.

3¢ Material Property Data

General Data
Material Name and Display Color
Material Type
Material Grade

Material Notes

Weight and Mass
‘Weight per Unit Volume:

Mass per Unit Volume 8,0048

Uniaxial Property Data

Modulus Of Elasticity, E

Cosfficient Of Thermal Expansion, A

Shear Modulus, G

Other Properties For Tendon Materials
Minimum Yield Stress, Fy

Minimum Tensile Stress, Fu

[] Switch To Advanced Propsrty Display

Y1880 C

Tendon

Grade 270

Modify/Show Notes...

Cancel

5.3.DEFINICION Y ASIGNACION DE SECCIONES

Las secciones y espesores de los distintos elementos se han extraido de la

bibliografia correspondiente a la obra del Palazzetto (mayoritariamente de revistas

técnicas italianas contemporaneas a la obra). Para la definicion de secciones en SAP2000

V.20.2.0 nos dirigimos al mend Define>Section Properties>Frame Sections/Area

Sections.
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5.3.1. SECCIONES DE BARRAS

5.3.1.1L

NERVIOS DE LA CUPULA

Para la seccion resistente de los nervios de la cupula se ha considerado la

simplificacion de una seccion rectangular de 10,7 x 33 cm y se le ha asignado un material

de HA-14. Para la definicion de esta seccién se asiste al menu Define>Section

Properties>Frame Sections>Add New Property>Concrete>Rectangular.

D 23D
;wxw&;:; e

S

B€ Rectangular Section

Section Name

nervios_10,7x33

Section Notes Modify/Show Notes.

Dimensions Section

Depth (13 ) 032

0,107

Width (12)

Section Properies.

Material Property Modifiers

+ | |HA 25 v Set Modifiers. Time Dependent Properties.

Concrete Reinforcement.

Display Coor [

Figura 30: Detalle de conformacion del nervio de
la ctpula. Fuente: Ugarte, 1958.

5.3.1.2. SOPORTES EN “’Y”’

Figura 31: Men0 de definicion de secciones en

SAP2000. Fuente: elaboracion propia.

Los soportes en <”Y’’ estan formados por secciones variables. Para asignar este

tipo de secciones se debe asistir al ment Define>Section Properties>Frame Sections>Add

New Property>Other>Nonprismatic. Previamente habremos definido cada una de las

secciones en las que varia el soporte de manera analoga a la de los nervios de la clpula.

También se ha asignado como material HA-14.

B Nonprismatic Section Definition

Nonprismatic Section Name

Section Notes.

Start Section

V_40x40 ~ | Y_90x90

[ v_s0x40 - 90x30

Modify/Show Notes.

End Section Length

vispiay Color [l

Length Type  EB3 Variation  ER2 Variation

o ||Parabolic | |Linear

Figura 32: Menu de definicion de secciones variables en

SAP2000. Fuente:

elaboracioén propia.
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5.3.1.3. CABLES DE POSTESADO

Los 14 cables de postensado de la cimentacion se reparten en el modelo real en
las dos caras, 7 cables en la cara superior y 7 en la inferior. Cada uno de los cables se
compone de 12 cables de diametro 7 mm. Para el modelo de andlisis, sin embargo, se van
a modelizar como un Unico cable postensado equivalente a los 14 primeros que atara cada
base de los 36 soportes. Para ello se ha calculado el diametro equivalente con valor igual
a 0,0907 mm. Para la asignacién del material se ha considerado el acero de postensado
que se utiliza en la actualidad, Y1860 C, debido a desconocer el tipo de acero original.
No obstante, posteriormente haremos un tanteo para ver qué tipo de acero es el realmente
utilizado. Se definira como carga térmica y se ajustard, como se explicara en el apartado
pertinente, a la deformacion eléstica real del anillo de cimentacion que se midio al
finalizar las obras de 5 mm. A la seccion de los cables se les ha quitado desde el menu
Assign>Frame>Property Modifiers, tanto el peso como su masa, ya que debido a la poca

inercia de la seccion deformarian en exceso, dando un resultado erroneo.

B Circular Section x

Section Name TendonGlobaEquivalente Display Color ]

Section Notes Medify/Show Notes..

Dimensions Section

Diameter (13 ) 10,0907
3 I

Properties

Material Property Modifiers Section Properties. .

+ | |y18s0C ~ Set Modifiers. Time Dependent Properties..

Cancal

Figura 33: Menu de definicion de seccion circular en SAP2000.
Fuente: elaboracién propia.
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5.3.2. SECCIONES DE 3DCARAS

5.3.2.1. ELEMENTOS PREFABRICADOS DE FERROCEMENTO

Las piezas prefabricadas de ferrocemento son de 2,5 cm de espesor, sobre ellas se
dispone una capa de hormigon de 3 cm reforzado con armaduras. Se ha decidido la
definicion de una Unica seccion que englobe los dos materiales, ya que estos trabajan de
manera solidaria por las conexiones de las armaduras. EI material aplicado es HA-14.

En una clpula esférica de espesor delgado, se originan principalmente tensiones
de compresidn simple y traccion. La clpula, por tanto, tiene un comportamiento préoximo

al de membrana.

:x: Shell Section Data x
Section Name ferrocemento 5,5 Display Color .
Section Notes Modify/Show...
Type Thickness
@ Shell-Thin Membrane
() Shell - Thick Bending
O Piate - Thin Material
O Plate Thick Material Name + |[HA-25 -
O Membrane Material Angle

O Shell - Layered/Monlinear
Time Dependent Properties

Set Time Dependent Properties...

Concrete Shell Section Design Parameters ctifiness Modifiers

Modify/Show Shell Design Parameters... Set Modifiers...

0K Cancel

Figura 34: Menu de definicion de seccion de area en SAP2000. Fuente:
elaboracion propia.
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5.3.22. ANILLO DE CIMENTACION

Para modelar el anillo de cimentacion se han definido dos espesores diferentes, de
40 cm y de 80 cm, ambos con material HA-14. La seccion de 40 cm es la que se aplica
de manera general y la de 80 cm, segun planos de detalles, es la utilizada en la base de 1
de cada 6 soportes, donde se realizaba el postensado de los cables con el sistema cono de
Freyssinet. Al aplicar dichas secciones, no quedan en la posicion correcta, ya que se
aplican sobre su plano medio. Para solucionar este problema se debe definir un nuevo
“’Joint Pattern’’ dede el menu Define>Joint Patterns>Add New Pattern Name. Una vez
definido debemos asignar a las secciones (shells unicamente) el “’Joint Pattern’’ creado,
en este caso lo hemos llamado “’Area IP’’ (de punto de insercion). Se consigue, con las
3dcaras con seccién 80 cm seleccionadas, desde el ment Assign>Area>Area Thickness
Overwrites (Shells)>User Defined Thickness Specified by Join Pattern>Join
Pattern>Area_IP>Scale Factor=1>Apply. Una vez aplicado el “’Area IP’’ con factor de
escala 1, nos dirigimos de nuevo al menu Assign>Assign Joint Pattern Data>Constant D=
- 0,2. De este modo conseguimos elevar 20 cm la seccion de 80 cm respecto de su eje de
insercion y que ambas secciones (de 40 cm y de 80 cm) queden enrasadas en su cara

inferior.

B Assign Joint Pattern Data X
General

Joint Pattern Name AREA_IP

Pattern Assignment Type
®) X Y, Z Multipliers (Pattern Value = Ax + By + Cz + D)

() Z Coordinate at Zero Pressure and Weight per Unit Valume

Pattern Value = Ax + By + Cz + D

Constant A o 1/m
Constant B a 1/m
Constant C a 1/m
Constant D 02
Restrictions Options
®) Use All Values ®) Add to Existing Values
() Zero Negative Values ) Replace Existing Values
() Zero Positive Values ) Delete Existing Values
| Reset Form to Default Values |
| QK | | Close | Apply

Figura 35: Menu de asignacion de Joint Pattern en SAP2000.
Fuente: elaboracioén propia.
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

Figura 36: Joint Pattern asignado a la seccion del anillo de cimentacion en SAP2000.
Fuente: elaboracion propia.

El modelo en modo de extrusién en SAP2000 v.20.2.0 queda de la siguiente

forma tras aplicar todas las secciones:

Figuras 37 y 38: Modelo en modo extrusion en SAP2000. Fuente: elaboracidon propia.
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5.4. EJES LOCALES Y PUNTOS DE INSERCION DE LAS BARRAS

La modificacion de los “’Insertion Points’’ tiene una consecuencia directa: las
leyes de esfuerzos cambian debido a que el axil presenta una excentricidad, que habra que
considerarla en la ley de momentos. La deformada al tener en cuenta la inercia y la flecha
si define bien la rigidez, aunque se haya modificado el “’Insertion Point’’ de ellas.

En el modelo se ha aplicado a las barras que conforman los nervios de la cipula
para que la rigidez de ella sea la correcta, de manera que la cara superior de los nervios y
de los prefabricados de ferrocemento queda enrasada. Para ello vamos al menu Assign >
Frame > Insertion Point > Cardinal Point = 8 (Top Center); Coordinate System=Local;
End i, End j, Local 2= 0,0275m. Es decir, desde el centro superior de la seccion asignada,

[XPRE]
1

la barra se desplaza en su eje 2 local, tanto en su extremo inicial COmo en su extremo

final *3>*, 0,0275 m (equivalente a la mitad del espesor de la cupula, de 5,5 cm).

Figura 39: Insertion Point aplicado a los nervios en
SAP2000. Fuente: elaboracion propia.

5.5. VINCULOS

Para las condiciones de apoyo, primero se plante6 la aplicacién del modelo
“Winkler’’ de losa flexible sobre suelo elastico mediante la aplicacion de muelles que
simulasen el comportamiento del terreno, compuesto por arcillas y gravas. Para ello,
primero se debia modelar la cimentacién como se ha explicado en apartados anteriores y
luego aplicarles los muelles desde Assign>Area>Area Springs, haciendo uso del
coeficiente de balasto ““K’’. No obstante, se desconocen los datos sobre el estudio
geotécnico de la obra y, ademas, es dato la deformacion horizontal elastica del anillo de
cimentacion (5 mm), por lo que, finalmente, se ha supuesto que el suelo resulta
indeformable en el eje z y se han liberado los desplazamientos horizontales en los 36

apoyos externos, para poder determinar de este modo, la tension de postensado a la que
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estan sometidos los cables de la cimentacion sin que existan coacciones de un terreno del
cual desconocemos sus caracteristicas.

En total se han definido 72 apoyos de la estructura, dos por cada 1 de los 36
soportes en ‘“Y”’. Las condiciones de apoyo se definen desde Assign>Joint>Restraints.
Para el apoyo externo se ha restringido Unicamente el desplazamiento vertical. Para el
apoyo interno se ha restringido todos los desplazamientos en los 3 ejes y solo se permite
el giro a traves del eje 2. Se han modificado los ejes locales de los nudos, girdndolos
alrededor del eje z para que el eje x quede orientado radialmente desde el centro de la
cUpula. De este modo la deformacidn horizontal en los nudos externos se podra medir en

el eje x directamente y el apoyo interno no coaccionara dicha deformacion.

):,:__ Assign Joint Restraints X }‘-‘;_ Assign Joint Restraints X
Restraints in Joint Local Directions Restraints in Joint Local Directions
[] Translation 1 ["] Rotation about 1 (] Translation 1 [#] Rotation about 1
] Translation 2 "] Rotation about 2 [+] Translation 2 [C] Rotation about 2
[+] Translation 3 ["] Rotation about 3 [+ Translation 3 [¥] Rotation about 3
Fast Restraints Fast Restraints
| | | [® o] | | |®
oK oK

Figuras 40 y 41: MenUs de Joint Restraints en SAP2000. Fuente: elaboracién propia.
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6. EVALUACION DE LAS ACCIONES

Las acciones se determinaran segin el CTE DB-SE, como normativa general; pero
en los casos en los que se deban tener en cuenta factores de caracter climatico o geografico
se consultara la normativa italiana NTC 2018.

El DB-SE, en su apartado ‘’3.3.2.1 Clasificacion de las acciones’’, propone una
clasificacion de las acciones en funcién de su variacion en el tiempo:

e Permanentes (Q): aquellas que acttan de forma constante sobre el edificio
sin variar su posicion y pudiendo tener magnitud constante (como el peso
propio) o no (como el pretensado).

e Variables (Q): aquellas que pueden actuar sobre el edificio o no actuar,
como lo son las debidas al uso 0 a acciones climaticas.

e Accidentales (A): aquellas cuya probabilidad de ocurrencia es pequefia

pero de gran importancia, como sismo, incendio, impacto o explosion.

6.1. ACCIONES PERMANENTES (G)

6.1.1. PESO PROPIO

Segun DB-SE, apartado 2.1: el peso propio a tener en cuenta es el de los elementos
estructurales, los cerramientos y elementos separadores, la tabiqueria, todo tipo de
carpinterias, revestimientos (como pavimentos, guarnecidos, enlucidos, falsos techos),
rellenos (como los de tierras) y equipo fijo.

La estructura en el Palazzetto constituye la forma final del edificio. Al aplicar las
secciones con los materiales a las barras y elementos finitos (3dcaras), SAP2000 ya tiene
en cuenta el peso de los materiales. Sin embargo, hay que aplicar la carga correspondiente
a los 5 cm de vermiculita (aislante sobre la cubierta), de 0,07 KN/m?. Ademas, se ha
tenido en cuenta la iluminacién del Palazzetto (18 casquetes metalicos con tirantes
colgados de los nervios) y los aspiradores de humo y altavoces que cuelgan de la linterna,

considerando una carga adicional de 0,1 KN/m?.
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6.1.2. PRETENSADO

La carga de pretensado es la carga que soportan los cables de la cimentacion (14
cables formados cada uno por 12 cables de diametro 7 mm). Se ha simplificado el modelo
definiendo una Unica seccién equivalente a los 14 cables como se ha explicado
previamente.

La carga de pretensado se traduce en una carga de temperatura, que se aplica desde
el mend Assign>Frame Loads>Temperature. Dado que se desconoce el tipo de acero
original de la construccion para el postensado de la cimentacion, no podemos definir a
priori la tension que ejercia, es decir su carga térmica. Conociendo la deformacion elastica
horizontal que experiment6 el anillo de cimentacion al finalizar las obras, de 5 mm,
podemos proceder con un tanteo partiendo del material actual para postensados, el acero
Y 1860 C.

Recordamos que se sustituyo en la cimentacion el sistema de muelles del método
“Winkler’” por apoyos con desplazamiento nulo en ¢l eje z y el resto libres. Ademas de
esto, se ha decidido eliminar la seccion resistente de hormigén ya que, al producirse una
deformacion de apertura, toda la secciéon del hormigon trabaja a traccion y, por tanto,
despreciamos su resistencia.

En primer lugar, calculamos la deformacion elastica producida por la cupula
debido al peso propio y a las cargas muertas sin que se ejerza ninguna tension por parte
de los cables de postensado, dando un resultado de 23,1 mm de apertura.

Después, comprobamos la deformacidn que provocaria Gnicamente el postensado
a la temperatura propia del acero actual Y 1860 C, es decir, -693 °C, dando un resultado
de -111,2 mm.

El tipo de acero, por lo tanto, sera:

Apertura (DEAD + CMP) — 5 _ 231 mm-—5mm
Apertura (PST) - 111,2 mm

Tipo de acero = = 302,75 fypost

Al que le corresponde, basandose en la referencia del acero Y 1860 C, una
temperatura de -112,80 °C para que la deformacién al combinar DEAD+CMP+PST sea

finalmente de 5 mm.
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6.1.3. ACCIONES SOBRE EL TERRENO

No se analiza debido a la simplificacion del modelo.

6.2. ACCIONES VARIABLES (Q)
6.2.1. SOBRECARGA DE USO (SCU)

Segun el apartado 3.1 del DBSE-AE, la sobrecarga de uso es el peso de todo lo

que puede gravitar sobre el edificio por razon de su uso.

En la tabla 3.1 tomamos el valor para sobrecarga de uso igual a 1 KN/m2.
Considerando una categoria de uso G1 (cubiertas accesibles Unicamente para

conservacion de inclinacion inferior a 20°). Esta sobrecarga de uso no se considera

concomitante con el resto de las cargas variables, segun la nota 7 de la misma tabla. El

valor indicado se refiere a la proyeccion horizontal sobre la cubierta.

Tabla 3.1. Valores caracteristicos de las sobrecargas de uso

Carga Carga
Categoria de uso Subcategorias de uso uniforme | concentrada
[KN/m?] [KN]
Viviendas y zonas de habitaciones en, hospi-
. A1l 2 2
A | Zonas residenciales tales y hoteles
A2 Trasteros 3 2
B | Zonas administrativas 2 2
C1 Zonas con mesas Yy sillas 3 4
c2 Zonas con asientos fijos 4 4
Zonas de acceso al Zonas sin obstaculos que impidan el libre
publico (con la excep- c3 movimiento de las personas como vestibulos 5 4
C | cién de las superficies de edificios publicos, administrativos, hoteles;
pertenecientes a las salas de exposicién en museos; etc.
categorias A, B, y D) ca %olnas destinadas a gimnasio u actividades 5 7
isicas
Zonas de aglomeracion (salas de conciertos,
C5 : 5 4
estadios, etc)
D1 Locales comerciales 5 4
D | Zonas comerciales D2 Supermercados, hipermercados o grandes 5 7
superficies
E | Zonas de trafico y de aparcamiento para vehiculos ligeros (peso total < 30 kN) 2 20™
F | Cubiertas transitables accesibles salo privadamente @ 1 2
Cubiertas accesibles o1® | Cubiertas con inclinacion inferior a 20° e ]| 2
G | unicamente para con- Cubiertas ligeras sobre correas (sin forjado) ™ 0,47 1
servacion @ G2 Cubiertas con inclinacion superior a 40° 0 2

Tabla 2: Valores caracteristicos de las sobrecargas de uso. Fuente: DBSE-AE.

6.2.2. ACCIONES SOBRE BARANDILLAS Y ELEMENTOS DIVISORIOS

No procede la evaluacién de esta accion por no disponer de estos elementos.
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6.2.3. VIENTO

Segun el apartado 3.3.2 del DBSE-AE, la accion del viento se define en general
como una fuerza perpendicular a la superficie de cada punto expuesto, 0 presion

estatica, ge que se expresa de la siguiente manera:

ge=qb-ce-cp
Siendo:

gb la presion dinamica del viento
ce el coeficiente de exposicién
cp el coeficiente de presion

Célculo de la presion dindmica del viento, gp:
Ob=0,5 - & - vp?
Siendo:

5 densidad del aire, 1,25 kg/m?,
Vb valor basico de la velocidad del viento

Dado que vy depende de la localizacion exacta del edificio se acude a la normativa
italiana NTC 2018 para conocer su valor. Se deben comparar las definiciones de
velocidad bésica del viento entre la NTC 2018 y el CTE para comprobar si es posible la
aplicacion del céalculo del DBSE-AE.

Segun la NTC 2018, la velocidad bésica de referencia vb es el valor promedio
durante 10 minutos, a 10 m de altura sobre el suelo en un terreno plano y homogéneo de
exposicion categoria Il (ver Tabla 3.3.11), que se refiere a un periodo de retorno TR = 50
anos.

En el DBSE-AE, el valor basico de la velocidad del viento corresponde al valor
caracteristico de la velocidad media del viento a lo largo de un periodo de 10 minutos,
tomada en una zona plana y desprotegida frente al viento (grado de aspereza del entorno
Il segin tabla D.2) a una altura de 10 m sobre el suelo. El valor caracteristico de la
velocidad del viento mencionada queda definido como aquel valor cuya probabilidad

anual de ser sobrepasado es de 0,02 (periodo de retorno de 50 afos).
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Las dos definiciones, por lo tanto, son analogas. Vy viene dado en la NTC 2018

por la siguiente expresion:

Vb= Vb0 - Ca

Siendo:

Vho  Velocidad basica de referencia a nivel del mar, asignada en la tabla 3.3.1
(tabla 3) en funcidn de la ubicacion de la construccion.
Ca coeficiente de altitud

ca=1 para as< ag
as
ca:1+ks(a—— ) para a0 < as<1500 m
0
Siendo:
ao, Ks pardmetros que dependen de la ubicacion de la
construccion (figura 42) y segun la tabla 3.3.1 del
NTC2018
as la altitud respecto del nivel del mar de la ubicacion de la

construccion.

Como as = 20 m (altitud de Roma), y segun la tabla 3.3.1 de la norma NTC2018,
a0=500 my ks = 0,37, entonces, Ca = 1. Vb0 =27 m/s.

Figura 42: Mapa de zonas de subdivison del territorio italiano. Fuente: NTC 2018.
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Tab. 3.3.1 -Valori dei parametri vy, o, ay, kg

Zona Descrizione Vo [m/s] | ag [m] k.

Valle d"Aosta, Piemonte, Lombardia, Trentino Alto Adige,

1 | Veneto, Friuli Venezia Giulia (con 1'eccezione della pro- 25 1000 0,40
vincia di Trieste)
2 | Emilia Romagna 25 750 0,45
Toscana, Marche, Umbria, Lazio, Abruzzo, Molise, Puglia,
3 | Campania, Basilicata, Calabria (esclusa la provincia di 27 500 0,37
Reggio Calabria)
4 |Sicilia e provindia di Reggio Calabria 28 500 0,36
Sardegna (zona a oriente della retta congiungente Capo
5 5 4
Teulada con I'Isola di Maddalena) 28 720 040
| Sardegna (zona a occidente della retta congiungente Capo
5 3
6 Teulada con I'Isola di Maddalena) 2 00 0,36
7 | Liguria 28 1000 0,54
8 | Provincia di Trieste 30 1500 0,50
9 | Isole (conl'eccezione di Sicilia e Sardegna) e mare aperto 31 500 0,32

Tabla 3: Valores de los parametros Vi, Ca Y Ks . Fuente: NTC 2018.

Entonces:

Vb= Vpo -+ Ca=27 - 1 =27 mls

Siguiendo con la definicion del DBSE-AE, q» queda de la siguiente manera:

Ob=10,5"8 - vp2=0,5- 1,25 - 27% = 455,625 N/m? = 0,455625 KN/m?

Calculo del coeficiente de exposicién, segun la expresion del apartado D.2 del
DBSE-AE, Ce:
ce=F-(F+7Kk)

Siendo:
F=klIn(max (z,2) /L)
k,L,Z pardmetros caracteristicos de cada tipo de entorno, segun

la tabla D.2 del DBSE-AE (tabla 4).

Tabla D.2 Coeficientes para tipo de entorno

Parametro
Grado de aspereza del entorno
k L (m) Z(m)
I Bord_e del mar o de un lago, con una superficie de agua en la direccion 0.156 0,003 10
del viento de al menos 5 km de longitud
Il Terreno rural llano sin obstaculos ni arbolado de importancia 0,17 0,01 1,0
Zona rural accidentada o Illana con algunos obstaculos aislados, como
m : - 0,19 0,05 2,0
arboles o construcciones pequefias
IV Zona urbana en general, industrial o forestal 0,22 0,3 50
v Centro de negocios de grandes ciudades, con profusion de edificios en 0,24 10 10.0

altura

Tabla 4: Coeficientes segln tipo de entorno. Fuente: DBSE-AE.



Por tanto:

F==kIn(max (z.Z) /L) =0,22 - In (5/0,3) = 0,619
ce=F - (F+7Kk)=0,619 - (0,619 + 7 - 0,22) = 1,34

Célculo del coeficiente de presion, cp, segun el anejo D del DBSE-AE, en su
Tabla D.13 (figura 43) Cubiertas esféricas:
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4 - N ; ff'f" -
4 N f AT IBTND
- . ! ARE E B Wie
. :__. >
k(/ ____________ c—t vEET ) e
Ve & ‘ /
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d=b B —
‘IL 'II' A (1)!_ ‘_://
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+CP‘ A
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+0,8 -
L= /?
+0,6 S T
ot .
+04 e ggﬁ" 1
e / !
+0,2 = # a
f” @ /
" [ . =
0.0 0,1 0.2 03,7 o4 05 » C(g/d=0)
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0.2 v i
§ g P ',,r
04 s ‘ /!
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\ /f\'\ !
: o/ . !
08 » ™~
. ~._
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) 7 7 ~
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' \\ dz'“ 17
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-1,6 a ,M’
A -
Cre \ 4

Figura 43: Coeficientes de presion para cubiertas esféricas. Fuente: DBSE-AE.

Pese a la diferenciacion de zonas (A, B, C) que se presenta en las figuras, se
aplicara el maximo valor de succidn correspondiente al punto B tanto para la situacion de
succion como para de presion en toda la cipula. De este modo nos quedamos del lado de
la seguridad. Ademas, el peso de la ctpula, al ser de hormigon, sera superior al de la

accion del viento y esta se podria entonces despreciar.
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

Siendo g/d = 0,125y f/d = 0,173:
cep,10 =cp=-0,73
Finalmente,

ge=qb-ce-cp=0,455625-1,34-0,73 = 0,446
ge (presion) = 0,446 KN/m?
ge (succion) = - 0,446 KN/m?

Podemos comparar la maxima succién con el peso propio de la cupula, en
SAP2000 desde el menu Display>Show Tables, elegimos la opcion de Analysis
Results>Structure Output>Base Reactions.

x Base Reactions

O X
File View Edit Format-Filter-Sot Select  Options
Units: As Noted Base Reactions ~
Fiter:
OutputCase CaseType GlobalFX GlobalFY GlobalFZ GlobalMX GlobalMY GlobalMZ  GlobalX GlobalY GlobalZ XCqg
Text KN KN KN KN-m KN-m KN-m m m m
DEAD LinStatic -1,898E-10 |  -9,748E-10 6,4B4E-08 -7,772E-08 6,674E-09 0 o 0
» CHP LinStatic -1E-1 -5,112E-11 1,147E-09 -1,184E-09 3,596E-10 0 o 0
< >
Record: 2 of2 | AddTables.. | [ Done |

Figura 44: Tabla de reacciones en SAP2000. Fuente: elaboracién propia.

Para comparar dichos valores, segun el DBSE en su tabla 4.1, se afectaran las

acciones por los coeficientes parciales de seguridad (y), siendo segun la consideracion de
estabilidad:

Peso propio de la cipula = 17860,12 KN - 0,9 >> 2455,26 KN - 1,5 = Resultante de la
maxima presion del viento (aplicada al area de la cipula = 5505,075 m?).

Por tanto, se despreciara el efecto del viento.
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6.2.4. ACCIONES TERMICAS

Por la simplificacion del modelo de andlisis no se tendran en cuenta.

6.2.5. NIEVE

Al tratarse de una accion que depende de los factores climaticos en funcién de la
localizacion del edificio, recurrimos, de nuevo, a la norma italiana NTC 2018 para

conocer su valor, el cual viene dado por la siguiente expresion:

Os= sk - Ui - Ce- Ct
Siendo:

gsk  valor de referencia de la carga de nieve en el suelo segun mapa 3.4.1
(figura 45)

Ui coeficiente de forma de la cubierta segun tabla 3.4.11 (tabla 5)

Ce coeficiente de exposicion segun tabla 3.4.1 (tabla 6)

Ct coeficiente térmico segun tabla

Se supone que la carga de nieve actla en direccion vertical y se refiere a la

proyeccion horizontal de la superficie del techo.

Zuna di carco dalla neve (]

= 11,50
\ B 21,00
30,60
9,

Fig. 3.4.1 - Zone di carico della neve

Figura 45: Mapa de zonas de carga de nieve. Fuente: NTC 2018.
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Como se aprecia en la figura, Roma esta situada en la Zona Ill, para un valor de
as< 200 m, gsk adopta un valor igual a 0,60 KN/m?. Siendo as la altitud respecto del nivel
del mar de la construccion.

Siendo a, la pendiente de la cubierta respecto de la horizontal, el valor de uisegun

la siguiente tabla adopta un valor igual a 0,80.

Tab. 3.4.I1 — Valori del coefficiente di forma
Coefficiente di forma 0Pea=30° 30° <a <60 az60°
60 —a)
( 0,0
30

1 08 08-

Tabla 5: Valores de los coeficientes de forma. Fuente: NTC 2018.

Para una construccion situada en una zona plana sin obstaculos y expuesta por
todos sus lados, sin edificios o arboles altos proximos, se considera un valor para Ce

igual a 0,9, segun la tabla inferior.

Tab. 3.4.1 - Valori di C; per diverse classi di esposizione

Topografia Descrizione Ce
Battuta dai | Aree pianeggianti non ostruite esposte su tutti i lati, senza costruzioni 0.9
venti o alberi pit alti !

Aree in cui non € presente una significativa rimozione di Eneve sulla
Normale costruzione prodotta dal vento, a causa del terreno, altre costruzioni o 1,0
alberi
Riparata Aree in cui la costruzione considerata é sensibilmente pit bassa del i1
para circostante terreno o circondata da costruzioni o alberi pit alti i

Tabla 6: Valores de Ce para distintas exposiciones. Fuente: NTC 2018.

El coeficiente térmico C;, a falta de un estudio detallado de las caracteristicas
exactas del aislamiento de la cubierta, se considerara 1. Este tiene en cuenta la reduccion

de la carga de nieve debido a su disolucion, causada por la pérdida de calor del edificio.

Finalmente, la expresion para gs queda:

Os=0sk - Ui - Ce- Ct=0,60- 0,8 - 0,9 - 1 =0,432 KN/m?
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6.3. ACCIONES ACCIDENTALES (A)
6.3.1. SISMO

Para el andlisis de la accion sismica se va a proceder con un modelo de analisis de

““Espectro de respuesta elastica’” segun la aplicacion de la Norma de Construccion

Sismorresistente, NCSE-02. La norma italiana NTC 2018, en referencia al ‘‘Decreto del

Ministero delle infrastrtture 14 gennaio 2008”’, también contempla este tipo de anélisis.

Por compatibilidad de factores intervinientes en el calculo de la funcion espectral y por

simplificacion del trabajo, se ha decidido obtener la aceleracion basica en Roma y

compararla con una aceleracion basica similar en Espafia para poder aplicar la norma

NCSE-02 en condiciones equivalentes.

Del “‘Instituto Nazionale di Geofisica e Vulcanologia’’, en su mapa de

peligrosidad sismica, se extrae la aceleracion basica en la ubicacion del proyecto, Roma,

que resulta ser de 0,15g, equivalente segun la NCSE-02 a la aceleracion basica de Cheste.

@.l ISTITUTO NAZIONALE DI GEOFISICA E VULCANOLOGIA

Mappa di pericolosita sismica del territorio nazionale
(rfenmeno: Ordinanza PCM del 28 aprle 2006 n. 3519, AR.1b)
espressa in termini di accelerazione massima del suolo
con probabiita di eccedenza del 10% in 50 anni
riferita a suoli rigidi (Vssw> 800 mys: cat A, punto 3.2.1 del D.M. 14.09.2005)
N

<0.025¢g

\
\
§ -~
n{{g.
)
/ ~/
# L w) (e
/i \
.
°
. > Sl 100180 s
e
Elsborszione: apthe 2004 T -
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—

Figura 46: Mapa de peligrosidad sismica en el territorio italiano. Fuente: Instituto Nazionale di

Geofisica e Vulcanologia.

62



Mediante el analisis modal por espectro de respuesta elastica, se calcula con
SAP2000, bajo un determinado movimiento sismico en el suelo, como se producen las
diaceleraciones por inercia'y como entra en carga la estructura. No aplica esfuerzos como
el método simplificado, sino que simula situaciones reales de movimiento, siendo estas
situaciones junto con la inercia las que generan deformaciones.

La NCSE-02 establece un espectro normalizado de respuesta elastica en la
superficie libre del terreno, para aceleraciones horizontales, correspondiente a un
oscilador lineal simple con un amortiguamiento de referencia del 5% respecto al critico,

definido por los siguientes valores:

SIT<Ta a(T)=1+1,5-T/Ta
SiTA<T<Ts a(T)=2,5
SiT>Ts a(T)y=K-CIT

Siendo:

a(T) Valor del espectro normalizado de respuesta elastica

T Periodo propio del oscilador en segundos

K Coeficiente de contribucion

C Coeficiente del terreno, que tiene en cuenta las caracteristicas
geotécnicas del terreno de cimentacién, segun la tabla 2.1 NCSE-02
(tabla 7)

Para un terreno Tipo 111, siendo el nuestro una mezcla de arenas y gravas, C

adopta el valor de 1,6 segun la siguiente tabla:

TABLA 2.1.
Coeficientes del terreno

Tipo de terreno Coeficiente C

I 1,
Il 1.
11l 1L
v 2,

(=] (o)) (¢ R a]

Tabla 7: Valores para el coeficiente C segun tipo de terreno.
Fuente: NCSE-02.

El valor de Ky de an/g, se extraen del Anejo 1 de la NCSE-02 para la ubicacion
de Cheste con la misma aceleracion béasica de Roma, tienen como valor 1,0 y 0,15

respectivamente.
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Donde:

La aceleracion sismica de célculo, ac se define como el producto:

toma el valor de 1,3 por tratarse de una construccion de especial
importancia (segun el punto 1.2.2, por ser una construccion de interés

cultural y también por preverse una ocupacién masiva de personas).

ac:S'p'

ab

para 0,1g< p - ap< 0,4g, toma el valor de:

S

1,25

ap
+ 3,33 (p- —— 0.1>(
g

C
1— —

1,25)

Aplicando estos valores y considerando un coeficiente de ductilidad de 2 segun el

apartado 3.7.3.1 para el célculo del coeficiente de respuesta [, asi como una

amortiguacion Q igual a 4 para una planta diafana segun la tabla 3.1 de la NCSE-02, el

espectro de respuesta eléastica par los periodos de oscilacion (T) y los factores de

amplificacion de la respuesta a (T), queda del siguiente modo:

K 1 an/g 0,15 u 2
c 1,6 P 1,3 Q 4
Ta 016 s 1,191422 1,093362074
Te 0,64 adg 0,23232729 B 0,546681037
1,245957543 0,87217028
0 1,00
016 250 —— NCSE02
064 250 3,00
075 213
0,8 2,00 2,50
09 1,78
1 1,60 2,00
12 133 \
14 114 1,50
16 1,00 \
18 089 1,00
2 080 \\
25 064 0,50
3 0,53 T
4 0,40 0,00 ‘ ‘ ‘ ‘
5 0,32 1 2 3 5
6 0,27

Figura 47: Espectro de respuesta elastica en Excel. Fuente: elaboracion propia.

64



6.3.2.

INCENDIO

No analizaremos su accion debido a la simplificacion del trabajo.

6.3.3. SISMO

No analizaremos su accién debido a la simplificacion del trabajo.

6.4. RESUMEN DE ACCIONES SOBRE EL MODELO

Clasificacion Tipo Valor Normativa aplicable
25 KN/m?® DBSE-AE
+
0,07 KN/m? CMP
Acciones Peso propio (vermircullta)
Permanentes (G) 0.1 kN/m? CMP
(instalaciones)
Pretensado -112,79 °C EHE-08
Acciones del terreno - DB-SE-C
Sobrecarga de uso 1 kKN/m? DBSE-AE
Acciones sobre DBSE-AE

barandillas y
elementos divisorios

Acciones Se desprecian sus | NTC 2018 (italiana)
Variables (Q) | Viento efectos por el peso | DBSE-AE
de la cupula
Acciones térmicas - DBSE-AE
. NTC 2018 (italiana)
2
Nieve 0,432 KN/m DBSE-AE
NTC 2018 (italiana)
Espectrode | pnp14/01/2008
respuesta elastica (italiana)
T o(T) NCSE-02
0 1,00
0,16 2,50
0,64 2,50
0,75 2,13
08 2,00
: Sismo 0.9 1,78
Acciones 1 1,60
Accidentales (A) 1,2 1,33
1,4 1,14
16 1,00
18 0,89
2 0,80
25 0,64
3 0,53
4 0,40
5 0,32
6 0,27
Incendio - DB-SI
Impacto - DBSE-AE

Tabla 8: Resumen de acciones sobre el modelo. Fuente: elaboracion propia.
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7. ASIGNACION DE CARGAS

Se mostrara en este apartado los menus desde los cuales se han asignado las
cargas, asi como la representacion grafica de estas por separado. Previamente se habran
definido los Load Patterns desde el menu Define>Load Patterns. Se han definido los
siguientes: DEAD (peso propio), CMP (cargas muertas permanentes), SCU (sobrecarga
de uso), SCN (sobrecarga de nieve), PST (postensado). La accion del viento se ha
despreciado y el sismo no se introduce como Load Pattern sino como Load Case,
deducidos de los modos de vibracion y del espectro elastico de respuesta; se han definido,

por su parte, los siguientes: SIMx, SIMy, SIMz, SIMxyz.

7.1. ACCIONES PERMANENTES (G)

7.1.1. PESO PROPIO (DEAD)

Con la asignacion de secciones definiendo las propiedades de los materiales,
SAP2000 asigna de manera automatica esta carga, a excepcion de los cables de
postensado toda la estructura tiene asignado HA-14, de 25 KN/m?.

7.1.1.1. CARGAS MUERTAS PERMANENTES (CMP)

Se asigna desde el menl Assign > Area Loads > Uniforms (Shells) > CMP.

Vermiculita de valor 0,07 kN/m? y cuelgue de instalaciones de valor 0,1 kN/m?.

170
170.
170
170.
170
170.
170
:: > 170
e g&“‘ﬁ;@}\
AAAAR IS N

RGN
VAN

L

)
A

avAYA)

170.

170,

170

170,

N/m2 170

Figura 48: Representacion grafica CMP en SAP2000. Fuente: elaboracion propia.
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7.1.2. PRETENSADO (PST)

Se aplica como carga térmica a la seccién del tendon equivalente desde el menu
Assign>Frame Loads>Temperature. Temperatura asignada de -112, 79 °C.

17,
-26,
35,
-43,
-52,
61,
69,
78,
-87.
-95,

-104,

°oc -113,

Figura 49: Representacion grafica PST en SAP2000. Fuente: elaboracién propia.

7.2. ACCIONES VARIABLES (Q)

7.2.1. SOBRECARGA DE USO (SCU)

Se asigna desde el men( Assign > Area Loads > Uniforms (Shells) > SCU.
Valor de 1 KN/m?.

' AVAHV vvv:ss:

KN/m? 1.~

Figura 50: Representacién grafica SCU en SAP2000. Fuente: elaboracién propia.
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7.2.2. SOBRECARGA DE NIEVE (SCN)

Se asigna desde el mend Assign > Area Loads > Uniforms (Shells) > SCN.
Valor de 0,432 KN/m?.

432
432,
432
432,
432

432,

T SRR
AARARIAIEE

i
VAVAVAVATRNAYE
FAVAVAVAO RN

ARAN

TR

B
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v

VAAAT

1 432,

N/m2 432

Figura 51: Representacion grafica SCN en SAP2000. Fuente: elaboracién propia.

7.3. ACCIONES ACCIDENTALES (A)

7.3.1. SISMO

Para la asignacidn de sismo modal espectral, definiremos en primer lugar de donde
proviene la masa, para que SAP2000 calcule bajo un determinado movimiento sismico
en la base, cdbmo entra en carga la estructura. Para ello nos dirigimos al mend
Define>Mass Source. Por defecto el origen de la masa esté en la hipotesis DEAD, habra
que afadir las cargas muertas permanentes CMP y un 60% de la sobrecarga de uso SCU,

en edificios pablicos, segun el apartado 3.2 de la NCSE-02.

Mass Source Name HCSEQ:

Mass Source
Element Self Mass and Additional lass.
Specified Load Patterns.

Hass lutipliers for Load Patterns

Load Pattern Mutiplier
cMP ~

scu 06 Lt

Modify

Delete

Figura 52: Men0 origen de la masa para sismo modal
en SAP2000. Fuente: elaboracidon propia.
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Para la definicion del espectro de respuesta elastica, desde el menu
Define>Functions>Response Spectrum, se ha creado una nueva funcion segun los valores
definidos en el apartado 6.3.1 y para una amortiguacion del 4%.

B4 Response Spectrum Function Definition *

Function Name Function Damping Ratio

[ncseoz_K1_c1,15 | 0,04
Define Function

Period Acceleration

1. Add
Function Graph
I
Display Graph (46292 , 0,3497)

Figura 53: Definicidn del espectro de respuesta
elastica en SAP2000. Fuente: elaboracion propia.

Finalmente se han definido los Load Cases, desde el menu Define>Load Cases,
para las direcciones de x, y, z; y ademas uno combinado de las tres direcciones. Segun el
apartado C.3.6.2.4 de la NCSE-02, la combinacion de los resultados para los diferentes
modos sigue la regla de la raiz cuadrada de la suma de los cuadrados, presentando una
aproximacion razonable cuando los distintos modos no pueden acoplarse por tener
periodos muy diferentes.

B Load Case Data - Response Spectrum X
Load Case Name Notes Load Case Type
Set Def Hame Modify/Show. Response Spectrum ~ | Design
Modal Combination Directional Combination
O cac ouc 1 @ s
() cac3
O Absolute O absolute
. Periodic « Rigid Type | SRSS v
O NRC 10 Percent pass o)
Previous (NCSEO2)
(O Double Sum L J

Modal Load Case Diaphragm Eccentricity
Use Modes from this Modal Load Case. WODAL hd
®) Standard - Acceleration Loading

O Advanced - Displacement Inertia Loading

Loads Applied
Load Type Load Name Function
ceel ut v | NCSE02 K1, v

ncseoasc i =

NCSE02_K1_C1 1,246

[] show Advanced Load Parameters.
Other Parameters

Hodsi Damping Constant 0,04 oaityishow.

Figura 54: Definicion la combinacion para sismo modal xyz en
SAP2000. Fuente: elaboracién propia.
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8. VERIFICACIONES BASADAS EN COEFICIENTES PARCIALES

En la instruccién EHE-08 se asegura la fiabilidad requerida adoptando el método
de los Estado Limite. Este método permite tener en cuenta el caracter aleatorio de las
variables de solicitacion, de resistencia y dimensionales que intervienen en el célculo a
través de un procedimiento de caracter semiprobabilista.

Para cada una de las situaciones de estudio se establecen las posibles
combinaciones de acciones, que consisten en un conjunto de acciones compatibles que se
consideraran actuando simultdneamente para una comprobacién determinada. Cada
combinacidn estard formada, por lo general, por las acciones permanentes, una accion
variable determinante y una o varias acciones concomitantes.

Segun la EHE-08, los Estado Limite son aquellas situaciones para las que, de ser
superadas, se considera que la estructura no cumple alguna de las funciones para las que

ha sido proyectada. Se clasifican en:

- Estado Limite Ultimo (ELU)
- Estado Limite de Servicio (ELS)
- Estado Limite de Durabilidad
En este trabajo, se analizarda ELU y ELS, obviando los efectos de Estado Limite

de Durabilidad por simplificacion del contenido del trabajo.

En el articulo 7°, la EHE-08 clasifica las situaciones de proyecto que se deben
tener en cuenta:

- Situaciones persistentes, las que corresponden a las condiciones de uso
normal de la estructura

- Situaciones transitorias, las que se producen durante la construccion o
reparacion de la estructura

- Situaciones accidentales, corresponden a condiciones excepcionales
aplicables a la estructura.

En el presente trabajo se abordara el estudio de las situaciones persistentes y las
accidentales debidas al sismo. El resto de las situaciones no se consideraran debido a la

simplificacion del contenido del trabajo.
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8.1. VALORES DE CALCULO DE LOS MATERIALES

Segun el apartado 15.2 de la EHE-08, los valores de calculo de las propiedades de
los materiales se obtendran a partir de los valores caracteristicos divididos por un
coeficiente parcial de seguridad. Los valores que adoptan dichos coeficientes se pueden
obtener de la tabla 15.3 del EHE-08 (tabla 9) para el estudio de los Estado Limite Ultimos.
Para el estudio de los Estado Limite de Servicio se adoptardn como coeficientes parciales

de seguridad valores igual a la unidad.

Tabla 15.3
Coeficientes parciales de seguridad de los materiales
para Estados Limite Ultimos

Hormigon Acero pasivo y activo
Ye Ts

Persistente o transitoria 15 1,15

Situacion de proyecto

Accidental 13 1,0

Tabla 9: Coeficientes parciales de seguridad de los materiales
para ELU. Fuente: EHE-08.

8.2. VALORES DE CALCULO DE LAS ACCIONES

El valor representativo de una accion es el valor de la misma utilizado para la
comprobacion de los Estado Limite Ultimos. Una misma accion puede tener uno o varios
valores representativos, que se obtienen afectando su valor caracteristico por un factor ;.

En general, para las acciones permanentes, el valor representativo es el valor
caracteristico. Para las acciones variables, pueden existir los siguientes valores

representativos:

- Valor de combinacion yo Q. Valor de la accion cuando actla con alguna
otra accion variable.
- Valor frecuente y1 Q. Valor de la accion que es sobrepasado en periodos
de corta duracidn respecto a la vida atil de la estructura.
- Valor cuasipermanente y2 Qk. Valor de la accion que es sobrepasado
durante una gran parte de la vida util de la estructura.
Para las acciones accidentales, por lo general, el valor representativo es el valor
caracteristico.
El valor de célculo, segun el articulo 12 de la EHE-08, resulta de multiplicar un
coeficiente parcial de seguridad por el valor representativo, quedando la expresion:
Fa=vyr- vi-Fk
Siendo:

Fq Valor de calculo de la accién F
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Yf Coeficiente parcial de seguridad de la accion considerada -tablas
12.1y 12.2 de la EHE-08- (tablas 10 y 11)
Vi Factor de combinacion, frecuente o cuasipermanente -tabla 4.2
del DBSE-AE- (tabla 12)
Fk Valor caracteristico
Tabla 12.1.a

Coeficientes parciales de seguridad para las acciones, aplicables
para la evaluacion de los Estados Limite Ultimos

Permanente ¥z =100 yg=135 g = 1,00 ¥z = 1,00
Pretensado yp= 1,00 e =1,00 yp=1,00 ye= 1,00
Permanente de valor no constante | =100 | y@=150 | yz=100 | yz =100
Variable 72=000 | y,=150 | %, =000 | y,=100
Accidental — — 14 = 1,00 ya=1,00

Tabla 10: Coeficientes parciales de seguridad para las acciones
ELU. Fuente: EHE-08.

Tabla 12.2
Coeficientes parciales de seguridad para las acciones, aplicables
para la evaluacion de los Estados Limite de Servicio

Permanente ¥g =100 7 = 1,00
Pretensado Armadura pretesa yp =095 ¥p=1,05

Armadura postesa yp =090 yp=110
Permanente de valor no constante g = 1,00 yge = 1,00
Variable 2 =0,00 ya = 1,00

Tabla 11: Coeficientes parciales de seguridad para las acciones
ELS. Fuente: EHE-08.

Tabla 4.2 Coeficientes de simultaneidad (y)

Vo v V2
Sobrecarga superficial de uso (Categorias segun DB-SE-AE)
* Zonas residenciales (Categoria A) 0,7 05 03
+ Zonas administrativas(Categoria B) 0.7 0.5 03
* Zonas destinadas al publico (Categoria C) 0,7 0,7 0,6
* Zonas comerciales (Categoria D) 0,7 0,7 0,6
+ Zonas de frafico y de aparcamiento de vehiculos ligeros con un peso total 0,7 0,7 06
inferior a 30 kN (Categoria E)
«  Cubiertas transitables (Categoria F) a
| s Cubiertas accesibles unicamente para mantenimiento (Categoria G) 0 0 0 |
Nieve
* paraaltitudes > 1000 m 0,7 05 0,2
| « para altitudes < 1000 m 0,5 0,2 0 |
Viento 0,6 0,5 0
Temperatura 0,6 0,5 0
Acciones variables del terreno 0,7 0,7 0,7

1 " - . .
M En las cubiertas transitables, se adoptaran los valores correspondientes al uso desde el que se accede.

Tabla 12: Coeficientes de simultaneidad v . Fuente: DBSE-AE.
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8.3. COMBINACION DE LAS ACCIONES

Las combinaciones de acciones para los Estados Limite Ultimos (ELU) segun la
EHE-08 son:

- Situaciones permanentes o transitorias:

2 YG.;Gk,j + Z }’G:JG;J +7pP +701Qks + 2 Y Yo, Qx,i
j=1 j=1

=1
- Situaciones accidentales:
> 76;Cit X Vs JGA‘; +¥pPe + VA + Vo ViiQus + 2 Y, ¥,k
j=1 j=1 i>1

- Situaciones sismicas:

Y V6 G+ 2 Vg JG;;.; +YpPe + Yalek + 2, V0, Y2iQui
j=1 j=1

i=1

Las combinaciones de acciones para los Estados Limite de Servicio (ELS) segun
la EHE-08 son:

- Combinacion poco probable o caracteristica:

2 VG,ij.j + 2 VG-=J-G,;:,; +¥pPe +701Qk1 + 2 YaiYo, Q.
j=1 j=1

=1
- Combinacioén frecuente:

z YG.ij‘j + 2 Vs JG;},; +¥pPc + Vo111 Qps + Z Va2 Q.
i=1 j=1 i=1

- Combinacién cuasipermanente:

276Gt 2 Vg J-Gf(,j +7pP + X ¥ VaiQk,
j=1 j=1 i=1

En este trabajo se analizaran las situaciones permanentes y la situacién accidental
especifica de sismo. Segun el DBSE en su apartado 4.4.2: en los casos en los que la accién
accidental sea la accion sismica, todas las acciones variables concomitantes se tendran en
cuenta con su valor casi permanente. En nuestro caso . para sobrecargas de nieve o uso
adopta valor nulo. Ademas, como se observa de las combinaciones propuestas por la
EHE-08 y en sus tablas 12.1 y 12.2, para situaciones accidentales, el coeficiente parcial
de seguridad, yr, adopta el valor de la unidad para las cargas permanentes, variables y
accidentales.
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La accion del viento se ha despreciado por comparacion con el peso de la cupula
de hormigon. Por otro lado, como se ha indicado con anterioridad, segun la nota 7 de la
tabla 3.1 del DBSE-AE, la sobrecarga de uso de la cubierta no es concomitante con el
resto de las acciones variables. Ambas circunstancias permiten una reduccion notable en

las combinaciones.

Pese a que la norma EHE-08, en las combinaciones de Estado Limite de Servicio,
no contempla las acciones accidentales, tales como sismo, se han introducido las
combinaciones para sismo en ELS, de modo que podremos ver el comportamiento frente
a deformaciones en situacion sismica, teniendo en cuenta el coeficiente de
comportamiento por ductilidad , introducido en el calculo del espectro de respuesta
elastica, que afectard de forma proporcional a la deformada visible desde los resultados
del SAP2000.

La tabla resumen de las combinaciones es la que sigue:

Combinaciones ELU para situaciones permanentes
ELUpu 1,35- G+ 1,5 Qscu
ELUpn 135-G+1,5- Qscn

Combinaciones ELU para situaciones sismicas

ELUsisu 1-G+1:Asimyzt1:-0-0Qscu
ELUsisn 1-G+1:Asiuxyzt1:0- Qscn

Combinaciones ELS poco probable o caracteristica
ELSppu 1-G+1-Qscu
ELSppn 1-G+1-Qscn

Combinaciones ELS frecuente
ELSfu 1-G+1-0-Qscu
ELSfn 1-G+1-0,2-Qscn
Combinaciones ELS cuasipermanente
ELScpu 1-G+1-0-Qscu
ELScpn 1-G+1-0-Qscn
Combinaciones ELS para situaciones sismicas

EL Ssisxu 1-G+2-SISx+0 - Qscu
ELSsisyu 1-G+2-SISy+0 - Qscu
ELSsiszu 1-G+2-S1Sz+0 - Qscu
ELSsisxn 1-G+2-SISx+0 - Qscn
ELSsisyn 1-G+2-SISy+0-Qscn
ELSsiszn 1-G+2-SISz+0 - Qscn

Tabla 13: Resumen de las combinaciones ELS y ELU. Fuente: elaboracion propia.

Las acciones permanentes (G) incluyen las hipétesis simples de DEAD, CMP y

PST, definidas en SAP2000 desde el menu Define>Load Patterns. Para la introduccion
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de las combinaciones en SAP2000, se debe acceder al mend Define>Load

Combinatios>Add New Combo.

9. COMPROBACION DE LOS ESTADO LIMITE DE SERVICIO
(ELS)

9.1. ESTADO LIMITE DE DEFORMACION

El Estado Limite de Deformacion se satisface si los movimientos en la estructura
son menores que unos valores limite maximos, los cuales fija el CTE en su DBSE. Esta
comprobacion se realiza para los casos en que las deformaciones puedan causar la puesta
fuera de servicio de la estructura por razones funcionales, estructurales, estéticas u otras.

La deformacidn total que se produce en un elemento de hormigén es el resultado
de la suma de diferentes deformaciones parciales, es decir, las flechas instantaneas y las
diferidas que se producen a lo largo del tiempo por efecto de las cargas introducidas, la

fluencia, retraccion del hormigoén y relajacion de las armaduras activas.

9.1.1. FLECHAS

Segun el apartado 4.3.3.1 Flechas, del Documento Basico de Seguridad
Estructural (DBSE), los valores limite maximos para movimientos verticales son los
siguientes:

- Cuando se considere la integridad de los elementos constructivos, se
admite que la estructura horizontal de un piso o cubierta es suficientemente
rigida si, para cualquiera de sus piezas, ante cualquier combinacién de
acciones caracteristica, considerando sélo las deformaciones que se
producen después de la puesta en obra del elemento, la flecha relativa es
menor que:

a) 1/500 en pisos con tabiques fragiles (como los de gran formato,
rasillones, o placas) o pavimentos rigidos sin juntas;

b) 1/400 en pisos con tabiques ordinarios o pavimentos rigidos con
juntas;

¢) 1/300 en el resto de los casos.

- Cuando se considere el confort de los usuarios, se admite que la estructura
horizontal de un piso o cubierta es suficientemente rigida si, para
cualquiera de sus piezas, ante cualquier combinacion de acciones
caracteristica, considerando solamente las acciones de corta duracién, la
flecha relativa, es menor que 1/350.
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- Cuando se considere la apariencia de la obra, se admite que la estructura
horizontal de un piso o cubierta es suficientemente rigida si, para
cualquiera de sus piezas, ante cualquier combinacion de acciones casi
permanente, la flecha relativa es menor que 1/300.

No se consideraran los efectos de flecha respecto a la integridad de los elementos
constructivos puesto que se trata de una cubierta exenta de elementos superiores o
inferiores que puedan ser dafados.

No se consideraran los efectos de flecha respecto al confort de los usuarios debido
a que la cubierta solo es accesible para mantenimiento.

Si se estudiaran los efectos de la flecha respecto a la apariencia de la obra. Segln
el apartado 4.3.2 del DBSE, los efectos debidos a las acciones de larga duracion se
determinaran mediante combinaciones de acciones del tipo casi permanentes. En nuestro
caso se refiere a la combinacion ELScpu o ELScpn, que al tomar el coeficiente de
simultaneidad w2 valor nulo, ambas combinaciones resultan la misma, llaméndola desde
este momento ELScp.

La limitacion por apariencia fija un valor limite de flecha relativa igual a 1/300 de
la luz. La flecha relativa es la diferencia de movimiento en el eje global z entre dos puntos
y la luz es el doble de la distancia en proyeccién horizontal entre ellos. Esta limitacion
hace referencia, por lo tanto, a las pendientes de deformacion. En la deformada de la
estructura se deberd observar el mayor movimiento vertical, asi como las maximas
pendientes.

Analizaremos los resultados extraidos del programa SAP2000. Estos resultados
de deformada se referirdn a la deformada de la estructura elastica instantanea, ya que el
programa utiliza un célculo lineal elastico. Para tener en cuenta los efectos de las
deformaciones diferidas de la estructura de hormigoén, y a modo de simplificacion, se
adoptara un coeficiente de mayoracion para flechas de valor igual a 2. Para la
determinacion de este valor se ha considerado que, al trabajar la ctpula principalmente a
esfuerzos de compresion, los efectos de fisuracion que también aumentarian la deformada

se pueden despreciar.
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Resultados en SAP2000 para ELScp:

PRI SRR PLObj 27
FATAVAR TN AT D[N PLEIm: 27
VAVAVAVAVAVAVAVAVANATANA CoaSotRy UT=0.0046
VAVAVAVAVAVAVAVANAYAYAN TR\ U2= 00011 .
ALNANNNINSINN AN U3=-0.0019 U
/ LN N R1= 000036 .

R2 =-0.00147
R3 = 7.352E-09

> PtObj: 177
y } : ¥ PLEIm: 177
> U1= 00007
U2 = 0.0002
U3 =-0.0081
R1= 0.00039
R2=-000115
R3 = -4.028E-09
\K R
an \ 3

| 4 \7\} 4

(&3

\‘
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Pt Obj: 1971
PtEIm: 1971
U1 = 0.0001
U2 = -0.0002
U3.=-00138
R1=-1E-05
R2 = -2E-05
R3= 1123E-08
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V4 VAVAVAVAVAVAVAAN AT BUR S

P VAVAVAVAVAVAVAYAN AV AN AN
VAVAVAYAVAVAVAVAVAVARANA
ZAVAVAVAVAVAVAVAVAVANANAY

SAP2000

Figuras 55, 56 y 57: Resultados en SAP2000 para la combinacion ELScp. Fuente: elaboracién propia.
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La flecha relativa (Ay) para la maxima pendiente es:
Ay =1-0,0081 + 0,0019| = 0,0062 m = 0,62 cm
Aplicando el factor de mayoracion para considerar los efectos diferidos:
Ay’ =2-0,62=1,24cm
El valor limite para la flecha relativa resulta:
1/300 - 2 distancia entre puntos = 1/300 - 2 - 4,59 = 0,0306 m = 3,06 cm
Comparando el valor limite con el real:
1,24 < 3,06
La flecha relativa (Ay) para el centro de la cupula es:
Ay =-0,0138 + 0,0019| =0,0119 m =1,19 cm
Aplicando el factor de mayoracion para considerar los efectos diferidos:
Ay’=2-1,19=238cm
El valor limite para la flecha relativa resulta:
1/300 - 2 distancia entre puntos = 1/300 - 2 - 59,2/2 =0,1973 m = 19,73 cm
Comparando el valor limite con el real:
2,38 << 19,73

Como se observa, la méaxima restriccion de flecha la impone la méaxima
pendiente que se da en la deformada de las piezas de ferrocemento de la imposta, para el
valor limite de 3,06 cm de flecha relativa. En el menu Display>Show Deform Shape,
podemos acotar la escala de colores entre valor nulo y el valor limite de flecha relativa.

Observando que, al no existir ninguna zona en magenta, toda la estructura cumple.

]

Figura 58: Resultados cumplimiento ELS. Fuente: elaboracién propia.

La estructura CUMPLE a flecha segun el apartado 4.3.3.1 Flechas del DBSE en

su consideracion de apariencia.
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9.1.2. DESPLAZAMIENTOS HORIZONTALES

Segun el apartado 4.3.3.2 Desplazamientos horizontales, del Documento Bésico
de Seguridad Estructural (DBSE), los valores limite méaximos para desplazamientos
horizontales son los siguientes:

- Cuando se considere la integridad de los elementos constructivos,
susceptibles de ser dafiados por desplazamientos horizontales, tales como
tabiques o fachadas rigidas, se admite que la estructura global tiene
suficiente rigidez lateral, si ante cualquier combinacion de acciones
caracteristica, el desplome (véase figura 4.1) es menor de:

a) desplome total: 1/500 de la altura total del edificio;
b) desplome local: 1/250 de la altura de la planta.

- Cuando se considere la apariencia de la obra, se admite que la estructura
global tiene suficiente rigidez lateral, si ante cualquier combinacion de
acciones casi permanente, el desplome relativo (véase figura 4.1) es menor
que 1/250.

- En general es suficiente que dichas condiciones se satisfagan en dos
direcciones sensiblemente ortogonales en planta.

Considerando la integridad de los elementos constructivos, la combinacion

caracteristica méas desfavorable es ELSppu, siendo los resultados en SAP2000 para esta

133E
14

9.5

combinacion:

76
57

38
Pt Obj: 20
PtEIm: 20 1.9
U1=0.0108
U2 =-0.0012 0
=% U3 =-0.0036
- R1=-000034 19
R2=-0.00318
~ R3 = -5.958E-09 38

Figura 59: Resultados en SAP2000 para la combinacién ELSppu considerando la integridad de los
elementos constructivos. Fuente: elaboracién propia.

Analizamos el desplazamiento horizontal en la imposta, que es donde se podrian

producir dafios a los ventanales que cierran perimetralmente el edificio.

El desplome total=1/500 - altura total del edificio=1/500 - 23,5 = 0,047 m=4,7 cm
Comparando el valor limite con el real: 1,08 < 4,7 cm

La estructura CUMPLE a desplazamientos horizontales segun el apartado 4.3.3.2
del DBSE en su consideracion de integridad de los elementos constructivos.
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Considerando la apariencia de la obra y analizando la combinacion de acciones

casi permanente, ELScp, los resultados en SAP2000 para esta combinacién son:

5_BE:B
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2,55

1.7
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= -0.0002 a7
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7
&

341
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mm -51

Figura 60: Resultados en SAP2000 para la combinacion ELScp considerando la apariencia de la obra.
Fuente: elaboracion propia.

El valor limite maximo = 1/250 - altura edificio = 1/250 - 23,5=0,094 m = 9,4 cm

Comparando el valor limite con el real: 0,54 cm < 9,4 cm

La estructura CUMPLE a desplazamientos horizontales segun el apartado 4.3.3.2

del DBSE en su consideracién de apariencia.

Ademas de las comprobaciones exigibles por la normativa, realizaremos el
analisis de las deformaciones horizontales para el anillo de cimentacion en condicion de

acciones casi permanentes y los efectos de sismo.

La apertura por deformacion eléstica del anillo de cimentacion que se midio,
segun fuentes bibliogréaficas, al finalizas las obras, fue de 5 mm. Como se ha explicado
en el apartado 6.1.2 Pretensado, al aplicar una temperatura de -112,79 °C la contraccion
que experimenta el material del tendon equivalente (PST) compensa, en parte, el peso
propio (DEAD) y las cargas permanentes muertas (CMP), de manera que restringe la
apertura elastica del anillo a 5mm, como se muestra en los resultados en SAP2000, para

la combinacion de acciones casi permanentes ELScp:
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Figura 61: Resultados de apertura del anillo de cimentacién en SAP2000 para la combinacién ELScp.
Fuente: elaboracion propia.

Los efectos del sismo, por su parte, al ser una estructura simétrica, son iguales en
ambas direcciones x e y. La deformacion horizontal que se da para la combinacion
ELSsisx es la que se muestra en los resultados de SAP2000 pero afectada por el
coeficiente de comportamiento por ductilidad p (NCSE-02, tabla3.1), que toma como
valor el de 2 (baja ductilidad).

( (5 S
\ L A\ +A L/ 77.
] e ! 66,

55.
44,

Pt Obj 20 22.

PtEIm: 20
U1= 00719 n

U2 =-0.0038
g U3=-00171 0.
| [—— = &7 R1=-000025
8 R2 =-0.00209 1.
4 \ R3=-1E-05

\v \ e -22,
‘t g )A_ o5
\ = = -33,

-44,
-55

/ = VANV~ mm -66.

Figura 62: Resultados en SAP2000 para la cofnbinacién ELSsisx. Fuente: elaboracién propia.

El desplome total = 1/500 - altura total del edificio = 1/500 - 23,5= 0,047 m = 4,7 cm

Comparando el valor limite con el real: 7,19 > 4,7 cm

Esta comprobacidn, pese a no estar sujeta a las exigencias de la EHE-02, el DBSE
0 la NCSE-02, nos da una idea de los desplazamientos horizontales que se producirian,

comprometiendo la integridad de los elementos constructivos.
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9.2. ESTADO LIMITE DE FISURACION

No se estudiaran sus efectos debido a la simplificacién del contenido del trabajo.
No obstante, sus efectos se pueden suponer despreciables al ser la cipula un elemento
que trabaja fundamentalmente a compresion y que, por tanto, limita los efectos de

fisuracion.

9.3. ESTADO LIMITE DE VIBRACIONES

No se estudiaran sus efectos debido a la simplificacién del contenido del trabajo.
Considerando que las estructuras de la cupula y del sistema de las gradas son
independientes, las vibraciones, producidas por el movimiento ritmico de las personas en
las gradas, podrian no afectar en gran medida a la clpula, pudiéndose considerar

despreciable su efecto.

10. COMPROBACION DE LOS ESTADOS LIMITE ULTIMOS (ELU)

Segun la EHE-08, los Estados Limite Ultimos engloban todos aquellos estados
que produzcan el fallo de la estructura, por pérdida de equilibrio, colapso o rotura de esta
o parte de ella. Como Estados Limite ultimos deben considerarse los debidos a fallo por
deformaciones plasticas excesivas, rotura o pérdida de la estabilidad; pérdida del
equilibrio de la estructura considerada como un sélido rigido y fallo por acumulacion de
deformaciones o fisuracion progresiva bajo cargas repetidas.

De ser superados los Estados Limite Ultimos, constituyen un riesgo para las
personas, debido a una puesta fuera en servicio del edificio o el colapso total o parcial del
mismo.

Para las comprobaciones de los Estado Limite Ultimos (ELU), se analizaran los
diagramas de esfuerzos de las barras. De ellos, extraeremos los esfuerzos axiles, cortantes

y flectores para las comprobaciones de resistencia.
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10.1. SOPORTEENY

Se va a realizar en este apartado la comprobacion a flexocompresion y a cortante
de uno de los 36 soportes de forma antropomorfica que sustentan la cupula.

El soporte, mediante secciones variables, representa la figura de un hombre
sosteniendo la cupula con sus brazos extendidos (bifurcacion superior), una pierna
estirada hacia detras para contrarrestar el empuje de la ctpula y transmitirlo al anillo de
cimentacion, y, la otra pierna, apoyada delante (que sostiene en fase de construccion el
peso propio del soporte). En la modelizacion en SAP2000 se han definido 3 secciones de
tipo variable, como se ha explicado en el apartado 5.3.2.1, que se asignan a las 4 barras
que conforman dicho soporte (dos brazos y dos piernas).

Las comprobaciones se realizaran para la seccién maxima y minima de cada una
de las 4 barras (ver anexos, figuras 92 y 93, donde se definen tanto las secciones de
hormigdn como su armado) que conforman el soporte (dos brazos y dos piernas),
coincidiendo con: las secciones de unién con la clpula a la altura de la imposta, la seccion
en la unién de las 4 barras y las secciones de las piernas en contacto con el terreno. Para
dichas secciones se analizard la combinacién ELUpu. Ademas, se analizara una de las

secciones con la combinacién ELUsis.

10.1.1. BRAZOS SOPORTE EN Y
10.1.1.1. SECCION 25x30 cm
Desde el mend Display>Show Forces/Stresses>Frames, para la tensién axial

obtenemos los siguientes resultados en SAP2000: a la izquierda los diagramas de axiles

sobre el modelo y a la derecha el anélisis particularizado de la barra.

3¢, Diagrams for Frame Object 86 (Y_58X90 - 25X30) X

End Length Offset Dispiay Options
Case |ELUpu v (Locaton) ;g5 Q Scroll for Values
tems  Axial (P and T) ~  Single valued LI “D"‘ @ Show Max
5

JEnd: | o.m
(5,79555 m)

Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Torsions in KN-m)
Dist Load (1-dir)

457,43 426,33

— < 7,37 KNim

—_ « 2t2,89777 m

399 399 Positive in -1 direction
esunaii

n Al oI ce

Axial

-457 428 KN
at0,m

Resultant Torsion

Torsion

-39,8986 KN-m
at5,79555 m

Reset to Intial Units Unts | KN,MC  ~

Figura 63: Diagramas de axiles del brazo del soporte en Y para la combinaciéon ELUpu en SAP2000.

Fuente: elaboracién propia. 83



Desde el menu Display>Show Forces/Stresses>Frames, para los momentos
alrededor del eje 3 (eje azul) obtenemos los siguientes resultados en SAP2000: a la
izquierda los diagramas de momentos sobre el modelo y a la derecha el analisis

particularizado de la barra.

Figura 64: Diagramas de momentos del brazo del soporte en Y (extremo j) para la combinacion
ELUpu en SAP2000. Fuente: elaboracion propia.

Extraemos que los esfuerzos en la imposta (extremo j de la barra) son:

Axil (Ng) -426,33 KN
Cortante (Vra1) -28,85 KN
Cortante (Vrd2) -30,26 KN
Momento (Mq) -36,58 KNm

Para que no se produzca colapso de la seccion frente a los esfuerzos a los que esta
sometida, comprobaremos que dichos esfuerzos estan en equilibrio con la resultante de
las tensiones en el material; como se muestra en la siguiente tabla y diagrama de

interaccion axiles-momentos:

120,00
N(M=0) 143422  [kN] Nmaxc 143422  [KN] Nmaxt 839,22 [kN]
y M 0,00 [kNm] M 0,00 [kNm]
Ao
/ M (N=0) 91,40 [kNm] N 27231 [kN] N 839,22 [kN]
/ \ Mmax+ 11143 [kNm] M max- 0,00 [kNm]
/ ISEAY
J \\
\ FLEXION SIMPLE DOMINIO 4a ESFUERZOS DE CALCULO
F i \.. Mult 91,40 [kNm] C.SEG. 1,8370 il Md 36,58 [kNm]
\ DOMINIO 3 C.5ATU. 05444 il Nd 426,33 [kN]
\ FIB. NT. 68,01 [mm] FIB. NT. 247,23 [mm] CUMPLE
g 40,08 \
‘-\ AXIL SIMPLE Bst 5 [mm] Vrdi [kN]
\ Nult (-} -1.434,22 [kN] Nst 2 i} vrd2 | 3026 | [kN]
o Nult(+) 838,22 [kN] st 200 [mm] Vui 181,63 [kN]
\ stmax 201 [mm] Vu2 62,61 [kN]
.:" ] ] e “i CRITERIO SEGURIDAD PEREPEREZ CORTANTE | sl | | CUMPLE |
~2.000,00 +1.500,00 ~1,000,00 500,00 ’ 000 500,00 1.000,00

Figura 65: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccién 25x30. Fuente: elaboracién propia.

84



Comprobamos que la seccion de 25x30 si CUMPLE a flexocompresion y

esfuerzo cortante en base a la normativa actual.

Nos encontramos en dominio 4a, es decir, todas las armaduras se encuentran

comprimidas pero el recubrimiento de hormigon de las armaduras de traccion se

encuentra traccionado.

10.1.1.2. SECCION 58x90 cm

_}(' Diagrams for Frame Object 84 (Y_58X90 - 25X30)

Case ELUpu

tems  Masjor (V2andM3) v Single vaiued

End Length Offset
(Location)

- it 82
HEnd: | o.m
©,m)
it 89
LEnd | o m
(5,79555 m)

Display Options

@ Scrol for Values
(O Show Max
Location

0, m

Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Moments in KN-m)

308,24

Cs

76 86

36,59

12

Resultant Moment

Deflections

) Absolte

Reset to initial Units

O Relative to Beam Minimum ®

/\

Relative to Beam Ends

Dist Load (2-dir)

14,49 KNim
ato,m

Positive in -2 direction
Shear V2

76,882 KN
at0m

Moment M3

-308,2445 KN-m
ato,m

Deflection (2-dir)

o.m
ato,m
Positive in -2 direction

Unts  KN.mC

Figura 66: Diagramas de momentos del brazo del soporte en Y (extremo i) para la combinacion
ELUpu en SAP2000. Fuente: elaboracion propia.

Extraemos que los esfuerzos en la union de las 4 barras (extremo i de la barra) son:

Axil (Na)

Cortante (Vra1)
Cortante (Vrd2)
Momento (Mq)

-457,42 KN
-76,88 KN
-33,36 KN
-308,25 KNm

VAN

g N(M=0)  -5.180,22 [kN] Nmaxc  -5.190,22 [kN] N max,t 1.048,02 [kN]
M 0,00 [kNm] M 0,00 [kNm]
\ M (N=0} 42576 [kNm] N 208152 [kN] N 104302 [kN]
M max,+ 794,87 [kNm] M max,- 0,00 [kNm]
.n a FLEXION SIMPLE DOMINIO 3 ESFUERZOS DE CALCULO
Mult 425,76 [kNm] C.5EG. 2,3564 i Md [ 30825 | mknm]
DOMINIO 2 C. SATU. 0,4244 o N [kN]
\ FIB. NT. 12591 [mm] FIB. NT. 330,41 [mm] | _cumpLE |
200, AXIL SIMPLE gse [ 6 |mm Vrd1 [kN]
\ Nult() 518022  [kN] st [ 2 | Vrd2 [kN]
‘Q Nult{+) 1.049,02 [kN] st | 200 | [mm] Vui 1.402,57 kN1
00 Y stmax 145 [mm] Vuz 241,90 [kN]
A
4 )Y CRITERIO SEGURIDAD PEREPEREZ CORTANTE [ wocwwmme ]
-6.00000  -5.000,00 -4.000,00 -3.000,00 -2.000,00 -1.000,00 0,00 1.000,00 2.000,00

Figura 67: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccion 58x90. Fuente: elaboracién propia.
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Comprobamos que la seccidn de 58x90 si CUMPLE a flexocompresién pero no
a esfuerzo cortante en base a la normativa actual.

Respecto al diagrama de interaccion axil-momento vemos que el resultado es
favorable, no obstante, el incumplimiento a cortante se debe a la limitacion de separacién
de estribos, que, de ser obviada, cumpliria con los requerimientos a esfuerzo cortante.

Nos encontramos en dominio 3, es decir, parte de la seccién se encuentra
comprimida y parte traccionada. La profundidad de la fibra neutra es mayor que 0,259d
por lo que el agotamiento se produciria por deformacion excesiva del hormigon en
flexion.

En esta seccion de 58x90 cm, al estar sometida a los mayores esfuerzos frente a
la combinacion para sismo, también se analizaré el cumplimiento a flexocompresion y
esfuerzo cortante para la combinacién ELUsis. Por simplificacion del contenido del

trabajo el resto de secciones solo se analizan para ELUpu.

3¢ Diagrams for Frame Object 97 (Y_58X90 - 25X30) X
End Length Offset Display Options
Case |ELUsis (Locaton) 4 & @® Scrol for Values
tems | Axial(PandT) v | MaxMinEnv HEnc gbm) O Show Max
, m;
it 102
1End: | o m Location

(5,79555 m) o, | m

Axial

Resultant Axial Force

-27,226 KN

e oy -514, 738 KN
T

Resultant Torsion

Torsion

I mytiasbine

at0,m

Reset to Intial Units unts  [kN.mC v

Figura 68: Diagramas de axiles del brazo del soporte en Y en su extremo i para la combinacién
ELUsis en SAP2000. Fuente: elaboracién propia.

x Diagrams for Frame Object 97 (Y_58X90 - 25X30) X

End Length Offset Display Options
G
(Location) gy @ Scrol for Values
EEEN 0, m O show Max
(0, my
It 102
JEnd: | o m

Shear V2

Case | ELUsis

tems  |Major (V2and M3) v MaxMinEnv v

Location

Resultant Shear

29814 KN

e | i

Resultant Moment

Moment M3

k 24820 R
I ———

-508,5083 KN-m
at0, m

Reset to nitial Units Unts  KN,mC v

Figura 69: Diagramas de momentos del brazo del soporte en Y (extremo i) para la combinacion
ELUsis en SAP2000. Fuente: elaboracion propia.
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La combinacion de sismo es una envolvente y puesto que puede actuar en dos

sentidos, los diagramas muestran dos valores por cada punto de barra. Se deben de adoptar

los valores mas desfavorables.

Extraemos que los esfuerzos en el extremo i de la barra, son:

Axil (Ng) -514,74 KN
Cortante (V1) -116,28 KN
Cortante (Vrd2) -84,00 KN
Momento (Mq) -508,51 KNm

¢
o:‘ FLEXION SIMPLE DOMINIO 3 ESFUERZOS DE CALCULO

/ Mult 425,76 [KNm] G.SEG. 1,2729 i} Mmd 508,51 [KNm]
/ DOMINIO 2 C.SATU. 07856 i} Nd 51474 [kN]

FIB.NT. 125,91 [mm] FIB. NT. 232,23 [mm] CUMPLE
AXIL SIMPLE @st 6 [mm] vrd1 [kN]
Nult () -5.190,22 IkN] Nst 2 1] Vrd2 [kN]
b Nult(+)  1.049,02 [KN] st 200 [mm)] vu1 141894  [kN]
Y stmax 146 [mm] vuz 250,09 [kN]

d b CRITERIO SEGURIDAD PEREPEREZ CORTANTH s | [ nwocumre |
6.000,00 5.000,00  -4.000,00 3.000,00  -2.000,00 1.000,00 0,00 1.000,00  2.000,00

Figura 70: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccion 58x90 frente a sismo. Fuente: elaboracion propia.

Comprobamos que la seccién de 58x90 si CUMPLE a flexocompresion pero no

a esfuerzo cortante en base a la normativa actual.

Respecto al diagrama de interaccion axil-momento vemos que el resultado es
favorable, no obstante, el incumplimiento a cortante se debe a la limitacion de separacién
de estribos, que, de ser obviada, cumpliria con los requerimientos a esfuerzo cortante.

Podemos apreciar que la seccion se encuentra ahora frente a sismo con un

coeficiente de saturacién mayor que para la combinacion ELUpu.
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT

10.1.2. PIERNA “TRASERA” SOPORTE ENY

10.1.2.1.  SECCION 90x90 cm

SAP2000

-+

e A e

Resutant Torsion

—

Reset to Intial Unts

1 Diagrams for Frame Object 79 (Y_40x40 - 90x90)
End Length Offset Display Options
Case | ELUpu (Locaton} ;. gy @ Scrol for Values
tems  Axial(PandT)  ~ | Singlevaued - e fbm: O Show Max
, m)
x 82
sEd | om R
(716834 m) 7,16834 m
Equivalent Loads - Free Body Diagram (Concenirated Forces in KN, Concentrated Torsions in KN-m)
Dist Load (1-ds
628,12 Rt bt
—_ e 13,23 KNfm
—_ 0t7.16834m
3.92E-06 392505  Posbven-1drecton

Axial

SST14KN
at 716834 m

Torsion

-3,924€-08 KN-m
at7,16834m

Units. KN, m, C

-

Figura 71: Diagramas de axiles de la pierna trasera del soporte en Y (extremo j) para la combinacion

ELUpu en SAP2000. Fuente: elaboracion propia.

Figura 72: Diagramas de momentos de la pierna trasera del soporte en Y (extremo j) para la

1 Diagrams for Frame Object 79 (Y_40x40 - 90x90) X
End Length Offset Display Options.
Location
case | ELUpu o ) 8t @ Scrol for Values
tems | Major (V2and M3) | Single valued LI l(lé m , O Show Max
. m
it 82
ot o Location
S e .
Equivalent Loads - Free Body Diagram (Concenrated Forces in KN, Concentrated Woments in Ki-m)
Dist Load (2-dir)
53,68 .11
21,07 KNim
D at7,16834m
II.GJ 1&45 Positive in -2 direction
[ ——
Shear V2
| 78451 KN
| at7,16834m
Resutant Moment
Moment M3
~112,107 KN-m
at7,16834m
Deflections
Deflection (2-dir)
| 7.306E-10m
at7,18834m
| Postive in -2 direction
O Absolute O Relative to Beam Minimum (@ Relative to Beam Ends.
Reset to Intial Unts Unts  [KN.mC v

combinacion ELUpu en SAP2000. Fuente: elaboracion propia.

Extraemos que los esfuerzos en la union de las 4 barras (extremo j de la barra) son:

ETSA UPV

Axil (Ng)

Cortante (Vra1)
Cortante (Vrd2)
Momento (Mg)

-557,11 KN
78,45 KN
63,82 KN
-112,11 KNm

2019-2020
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N(M=0)  1.45528 [kN] Nmaxc  -7.83834  [kN] Nmaxt 151234 [kN]
\ M 347 [kNm] ™M 1347 [kNm]
M (N=0) 569,04 [kNm] N 341880  [kN] N 151234 [kN]
¢ ! Mmax+ 112151  [kNm] M max.- 2317 [kNm]
f‘ FLEXION SIMPLE DOMINIO 4a ESFUERZOS DE CALCULO
/ Mult 569,04 [kNm] C.SEG. 8,4590 il Md [kNm]
DOMINIO 2 €. SATU. 0,1182 il Nd [kN]
FIB. NT. 139,59 [mm] FIB. NT. 698,01 [mm] | _cumpLE |
\
‘6 AXIL SIMPLE st 6 [mm] Vrd1 [kN]
/ \ Nult(-) 146528  [KkN] Nst 2 il Vrd2 [kN]
- 4 Nult{+) 1512,34 [&N] st 200 [mm] vut 2.159,64 [kN]
-10.000,00 -8.000,00 -6.000,00 -4.000,00 -2.000,00 0,00 € 000,00 stmax 94 [mm] Vu2 308,36 [kN]
GRITERIO SEGURIDAD PEREPEREZ CoRTANTE [ 5T T —

Figura 73: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccion 90x90. Fuente: elaboracidn propia.

Comprobamos que la seccién de 90x90 si CUMPLE a flexocompresion pero no

a esfuerzo cortante en base a la normativa actual.
Nos encontramos en dominio 42 mismo caso que para 10.1.1.1. El incumplimiento

a cortante se debe a la limitacion de separacidon de estribos, que, de ser obviada, cumpliria

con los requerimientos a esfuerzo cortante.

10.1.2.2. SECCION 40x40 cm

13 Diagrams for Frame Object 79 (¥_40x40 - 90x30) X
End Length Offaet Display Optons
Case ELUpu v (Locaton) . 1 ® Scrol for Valies
toms | Major (V2and M3) v | Single vaked HEng o O Show Max
m
X a2
= Locator
7.16834 m) 0, m
Equivalent Loads - Free Body Disgram (Concentrated Forces in KI, Concentrated Moments in Ki.m)
Dist Load (2-dir)
53,64 112,11
416 Kim
'y D ato,m
1.9 L 45 Postive -2 drecton
Shear v2
-11,993 KN
ato,m
Resutant loment
Moment M3
53,6838 KN-m
ato,m
Defectans
Deflection (2-dir)
om
ato,m
—‘_\\_‘\—/ Postive in -2 direction
O Absobte (O RestivetoBeamMimum (& Relative to Beam Ends
=TT T

Figura 74: Diagramas de momentos de la pierna trasera del soporte en Y (extremo i) para la
combinacion ELUpu en SAP2000. Fuente: elaboracion propia.

Extraemos que los esfuerzos en la union de las 4 barras (extremo i de la barra) son:

Axil (Ng)
Cortante (Vra1)
Cortante (Vra2)
Momento (Mq)

-628,12 KN
-11,99 KN
-8,63 KN
53,68 KNm
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/ 108, N(M=0) 168894  [kN] Nmaxc  -1.68594  [kN] N max;t 41961 [kN]
™M 0,00 [kNm] ™ 0,00 [kNm]
M (N=0) 68,50 [kNm] N 605,31 [kN] N 41961 [kN]
m\ Mmaxs+ 127,61 [kNm] M max,.- 0,00 [kNm]
FLEXION SIMPLE DOMINIO 4a ESFUERZOS DE CALCULO

_9 Mult 68,50 [kNm] C.SEG. 1,6631 ] Md [kNm]
/ DOMINIO 2 C.SATU.  0,6013 ] N 628,12 [kN]
2 [_cumpLe |

FIB. NT. 61,70 [mm] FIB. NT. 335,50 [mm]

\

\ AXIL SIMPLE ot [ 6 ]mm) Vvrdt [kN]

\ Nult(-) 168894  [kN] st [ 2 1 Vraz [kN]
Nult(+) 419,61 [kN] st [__200 | [mm Vu1 499,80 [kN]

_‘t' q stmax 212 [mm] vu2 122,52 [kN]

» CRITERIO SEGURIDAD PEREPEREZ CORTANTE [ sl | | CUMPLE |

o
-2.000,00 -1.500,00 -1.000,00 -500,00 0,00 500,00 1.000,00

Figura 75: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccidn 40x40. Fuente: elaboracidn propia.

Comprobamos que la seccion de 40x40 si CUMPLE a flexocompresion y

esfuerzo cortante en base a la normativa actual.

Nos encontramos en dominio 4a, es decir, mismo caso que en 10.1.1.1.

10.1.3. PIERNA “DELANTERA”’ SOPORTEEN Y

En esta barra, el apoyo se ha idealizado como una articulacion segun el apartado
5.5. Debido a esto, el momento en el extremo i de la barra es cero y, por tanto, no existe
interaccion del momento flector.

Puesto que en el extremo i de la barra no hay momentos por la simplificacion
adoptada la comprobacion frente a ELU se hara respecto del extremo j, donde la seccién
genérica experimenta un recrecido para acoger la union de las otras tres barras,
conformando una seccion de 140x40 cm. El armado en este punto no queda claramente
plasmado en los planos de detalle, por lo que se hara una aproximacion considerando

como armado base 4 redondos de didmetro 16 mmy 2 de didmetro 12 mm.
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ANALISIS DE LA ESTRUCTURA DEL PALAZZETTO DELLO SPORT SAP2000

10.1.3.1. SECCION 140x40 cm

1€ Diagrams for Frame Object 80 (¥_30%40 - 68¢40) X
End Length Offset Display Options
t

case |ELUpu v (ecatom) . g3 O Serol for Values
tems | Axial(PandT) v | Singlevalied = (Bfan) @ Show Max

it 82

JEnd: | om
(4,23576 m)

Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Torsions in KN-m)

Dist Load (1-dir)
371,42 96
—_— “«—  T74KNm
—_ at4.23576m
3,57E-05 3,57?_; Positive in -1 direction
RSN ARE PO
Axial
37147 KN
ato,m
Resutant Torsion
Torsion
| -3,572E-08 KN-m

| 81423576 m

Reset o Intial Units unts  [KNmMC

Figura 76: Diagramas de axiles de la pierna delantera del soporte en Y para la combinacién ELUpu
en SAP2000. Fuente: elaboracién propia.

3¢ Diagrams for Frame Object 40 (¥_30x40 - 68:c40) x
End Length Offset Display Options
Location;
e e O shoe i
o
Je 37
om Location

(4,23576 m) 2,11778| m

Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Moments in KH-m)
Dist Load (3-dir)

438,28

0, KNim
I D at2 1778 m
1

3,47  Postive in -3 direction

Shear V3

103,47 KN
at2, 1778 m

Resultant Moment

Moment M2

-219,1275 KN-m
at2 1778 m

Deflzctior

Deflection (3-dir)

-0,003074 m

|

at2, 1778 m
Postive in -3 direction
O Absolte O Relative to Beam Winimum @ Relative to Beam Ends
Rossto iUt s

Figura 77: Diagramas de momentos de la pierna delantera del soporte en Y para la combinacion
ELUpu en SAP2000. Fuente: elaboracion propia.

Extraemos que los esfuerzos en la unién de las 4 barras (extremo i de la barra) son:
AXxil (Nq) -371,42 KN
Cortante (Vrd1) 103,47 KN
Cortante (Vrd2) 103,47 KN
Momento (Mq) -219,12 KNm
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+000,06-

FLEXION SIMPLE DOMINIO 5) ESFUERZOS DE CALCULO
/ Mult 185,14 [KNm] C.SEG. 3,6627 i} Md 218,00 [KNm]
/ DOMINIO 2 C.SATU.  0,2730 i} Nd -371,42 [KN]
" FIB.NT. 124,28 [mm] FIB. NT. 538,60 [mm] CUMPLE
/ AXIL SIMPLE @st 3 [mm] Vrd1 [kN]
Nult () 297,22 [kN] Nst 2 1] Vrd2 [kN]

/ X Nult(+) 358,41 [kN] st 200 [mm] vut 188717 [kN]
/ stmax 212 [mm] Vu2 263,15 [kN]
— AR CRITERIO SEGURIDAD PEREPEREZ CORTANTE s ] [ CUMPLE |
OM0 S0 4000 20000 200000 -l0mo 000 100000

Figura 78: Diagrama de interaccion adimensional a flexocompresion. Cumplimiento a
flexocompresion y a esfuerzo cortante de la seccién 140x40. Fuente: elaboracion propia.

Comprobamos que la seccion de 140x40 CUMPLE a flexocompresion y esfuerzo
cortante en base a la normativa actual.

Nos encontramos en dominio 3, mismo caso que para 10.1.1.2.

10.2. CUPULA

La cupula, compuesta por las piezas prefabricadas de ferrocemento, trabaja, al ser
de pared delgada, principalmente a esfuerzos de compresion simple y traccion. Estas
piezas, que se organizan en 13 tipos, la mayoria de forma romboidal, forman en su unién
una acanaladura donde se conecta el armado interior de unas piezas con otras al
hormigonarla. Los nervios que se conforman sirven para rigidizar la superficie y evitar
las abolladuras pero la cpula trabaja de manera monolitica a modo de membrana.

La comprobacion simplificada que se va a realizar respecto de la clpula consiste
en determinar si es capaz de soportar los esfuerzos de compresion y traccién a los que
esta sometida.

Segun los resultados en SAP2000, las tensiones de compresion que se producen
en la cdpula no superan la resistencia a compresion del hormigén HA-14, siendo su
resistencia de célculo:

fod = 14/1,5 = 9,3 MPa = 9333 KN/m?

Estableciendo este valor como limite inferior de tensiones a compresion vemos

que, al no aparecer ninguna zona en magenta, no se supera en ningun punto la resistencia

a compresion del hormigon.
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Figura 79: Resultados de tensiones de compresion en SAP2000 para la combinacién ELUpu. Fuente:
elaboracion propia.

Los esfuerzos de compresion evitan la fisuracion del hormigdn. No obstante, en
el perimetro de la imposta, las tensiones de traccion deberan ser absorbidas por la malla
de redondos ortogonal que se sitda por encima de los elementos prefabricados, embebida
en la capa de compresion. Segun el detalle inferior, y conociendo que los redondos en el
interior del ferrocemento son de didmetro 6 mm, por comparacién, se aproxima que los

que forman la capa de compresion podrian ser de diametro 12 mm.
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Figura 80: Resultados de esfuerzos axiles en SAP2000 para la combinacion ELUpu. Fuente:
elaboracion propia.
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Segun la figura inferior, los resultados en SAP2000 definen un valor promedio de
traccion por unidad de medida (por cada metro lineal) maximo de 147,45 KN. Se podria
absorber dicha traccion con 4 redondos de didmetro 12 mm (Usq = 157,2 KN, acero
fyk=400MPa) en la direccion estudiada. Para cubrir un metro lineal deben separarse 25
cm a ejes, medida que se ajusta a la separacién mostrada en el detalle, por lo que las

tensiones de traccion quedan cubiertas por el armado dispuesto en el modelo real.
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Figura 81: Resultados de esfuerzos promedios por unidad de ancho en las direcciones principales en
SAP2000 para la combinacion ELUpu. Fuente: elaboracion propia.

94



BLOQUE 3: CONCLUSIONES

Las obras de Pier Luigi Nervi no comienzan con formulas, la sensibilidad estética,
desde la etapa de disefio, une la experiencia adquirida a través de la practica estructural y
el conocimiento tedrico sobre las leyes del mundo fisico. El Palazzetto dello Sport
culmina su “’Sistema Nervi’” desde el punto de vista estatico, constructivo, econdmico y
arquitectonico.

Estaticamente se ha analizado el Palazzetto, del que se van a extraer conclusiones
de su comportamiento; constructiva y econdmicamente cabe recalcar no solo la economia
en recursos materiales sino también en plazos de ejecucion, montandose la cupula en 30
dias y la totalidad del edificio en tan solo 8 meses. La prefabricacion y el uso del
ferrocemento permiten esta economia que Nervi define como honestidad intelectual,
aprovechar los recursos de manera Optima. La prefabricacién, sin embargo, no lo
desvincula del lugar de la construccion, sino que, por el contrario, siendo el Unico
propietario de las patentes de los procesos constructivos para sus obras, lo vincula de
manera inherente a ellas, destacando su papel como constructor, pues para Nervi una obra
arquitectonica no se puede considerar como tal hasta que no se hace realidad viva de
materiales.

Segun el propio Nervi, la caracteristica fundamental del Palazzetto es la
independencia completa de la cupula respecto al sistema de gradas y servicios inferiores
(Nervi, 1965). Es por ello por lo que la simplificacion adoptada en este trabajo se centra
en el analisis del comportamiento de la cupula sustentada por los 36 soportes

antropomorficos y cimentada sobre el anillo postensado.
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Figura 82: Vista interior etapa constructiva. Fuente: lori, 2009.
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Se extraeran conclusiones desde la base, es decir, en primer lugar, se valoraran los
resultados fruto del andlisis de los cimientos para después pasar a los soportes y finalizar
con el elemento de cubricion, la cipula.

Respecto al anillo de cimentacidn, segun los planos de detalle originales a 1:10
que se adjuntan en los anexos (figura 90), estaba formado por una seccién de hormigén
en la cual estaban embebidos 14 cables postensados, repartidos en su cara superior e
inferior, con el sistema enfundado de cono Freyssinet. Como la deformacién elastica del
anillo de cimentacion resultd, al final la obra, de una apertura del radio en 5 mm v,
ademas, se puede despreciar la resistencia a traccion del hormigén, no se ha considerado
la seccion del hormigdn para la resistencia a la apertura de la cimentacion. EI empuje de
la capula es, por tanto, absorbido en el anillo por los cables de postensado Unicamente,
esto se ha simplificado en el modelo ideal a un Unico tendon equivalente. Tras tantear la
carga de temperatura a la que debe estar sometido para que experimente la retraccién
adecuada (apertura del radio del anillo en 5mm), resulta un acero con tension de limite
elastico 303MPa (referente a una carga térmica de -112,80 °C), se observa que el valor es
muy inferior a los 1860 MPa (para -693 °C) del acero actual de referencia en postensados.
El postensado en la cimentacion, por lo tanto, no esta optimizado, existiendo un exceso
en cuantia de acero dispuesto para los esfuerzos que transmite la cupula. El resultado
obtenido, no obstante, no ha tenido en cuenta el efecto de relajacion que experimenta el
postensado que puede suponer una tension inicial del orden de un 20 a un 30% superior
a la que se ha definido para conseguir la apertura de 5mm, ni tampoco las deformaciones
diferidas de la ctpula. Por otro lado, Nervi permanece ajeno al uso del pretensado, siendo
el Palazzetto una de las pocas aplicaciones en su obra (Nardiz, 2017), lo que explicaria el
exceso de acero empleado.

En cuanto a los soportes, con su simil antropomorfico de hombres sosteniendo la
clpula, se potencia la expresion de lo resistente, que, siguiendo la teoria de la empatia,
transmite al espectador de la obra los sentidos relativos a la distribucion de cargas que se
producen. Los esfuerzos a los que estan sometidos los soportes se plasman en su variacion
de secciones siguiendo la intuicion estatica de Nervi. Podemos comprobar que las

mayores secciones se dan donde concurren los mayores esfuerzos.
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A

Figura 83: Diagrama de momentos para el soporte en Y, combinacion ELUpu.
Fuente: elaboracidn propia.

Analizando el extremo “i’” de uno de los brazos, de seccidn construida 58x90 cm,
podemos acotar hasta qué punto se hubiera podido reducir la seccion, para los mismos
esfuerzos, manteniendo la proporcion base-canto y reduciendo la armadura manteniendo
la separacion entre las barras prevista. Comparando los diagramas de interaccion
adimensional a flexocompresion, entre la seccion de 58x90 y la propuesta como posible
alternativa, de 64x44; observamos que la primera presenta un coeficiente de saturacion
del 42% mientras que para la segunda es del 98% (quitando 2 barras de las propuestas en
la seccion inicial en las caras superior e inferior y manteniendo los didmetros del6 mmy

las armaduras centrales) en la combinacion ELUpu.
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Figura 84: Comparacion de diagramas de interaccién adimensional a flexocompresién. Cumplimiento
a flexocompresion y a esfuerzo cortante, ajuste de la seccién 58x90. Fuente: elaboracién propia.

Con las nuevas herramientas informaticas, en este caso con el uso de SAP2000,
podemos prever mas fielmente el comportamiento estatico de las estructuras y optimizar

Sus secciones.
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Por ultimo, despues de haber analizado la cupula, podemos concluir que, al ser de
pared delgada, trabaja principalmente a esfuerzos de compresion simple y de traccion. En
el esquema inferior observamos la deformada que se produce en un casquete esférico

donde al aplicar una carga puntual centrada, los esfuerzos de compresion se producen en

el centro mientras que en los extremos aparecen tracciones.

v

Figura 85: Esquema de la deformada de una clpula de casquete esférico.
Fuente: elaboracion propia.

Del anélisis se concluye que las tensiones de compresion que se producen en la
cupula no superan la resistencia a compresion del hormigon HA-14 (9,3 MPa). Los
esfuerzos de compresion evitan la fisuracion del hormigén mientras que los esfuerzos de
traccion son absorbidos por las armaduras de la capa de compresion.

Para Pier Luigi Nervi la teoria de las estructuras debe tener como objetivo la
determinacion de las tensiones internas, para poder definir en fase de disefio las secciones
resistentes siguiendo el criterio universal de la economia (Nervi,1945). En sus obras y
enfrentandose a la insuficiencia de los célculos previos recurria a modelos a escala que
simulaban el comportamiento de la estructura. Hoy, gracias a la simulacion de modelos
idealizados en herramientas informaticas como el SAP2000, podemos hacer una
aproximacion mayor al comportamiento de las estructuras espaciales. Sin embargo, pese
a los avances llevados a cabo en los célculos, el comportamiento del hormigén armado
resulta todavia dificil de definir con exactitud mediante estas herramientas informaticas,
siendo los resultados del calculo lineal eléstico, por tanto, solo una aproximacion al
comportamiento real de la estructura.

El modelo idealizado se ajustara tanto mas a la realidad cuanta mayor experiencia
se tenga, no solo en la teoria de las estructuras sino también en la préctica de la
construccion. Esta experiencia se traduce en la teoria nerviana como sensibilidad estatica,
la cual define de la siguiente manera: ‘’El hecho de idear un sistema resistente es un acto
creativo que se basa, solo en parte, en datos cientificos; la sensibilidad estatica que lo
determina, queda como la sensibilidad estética, como una capacidad puramente personal,
0 mejor dicho, el fruto de la compresion y de la asimilacion, llevado a cabo en el espiritu

del proyectista, de las leyes del mundo fisico’” (Nervi, 1945).
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Figuras 86 y 87: Planta y alzado del Palazzetto dello Sport. Fuente: lori, 2009.
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Figuras 88 y 89: Planta y seccion del Palazzetto dello Sport. Fuente: lori, 2009.
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Figura 90: Detalles a 1:10 del anillo de cimentacidn. Fuente: lori, 2009.
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Figura 91: Detalles a 1:10 de una pieza genérica de ferrocemento. Fuente: lori, 2009.
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Figuras 92 y 93: Detalles a 1:20 del armado de los soportes en Y. Fuente: Olmo y Chiorino, 2010.
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Figura 94: Pier Luigi Nervi frente al Palazzetto dello Sport. Fuente: lori, 2009.
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